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[bookmark: _Toc454951878]Get Started Right Away
This lab manual was developed based on the students’ projects in mobile computing and security that were implemented at Alabama A&M University since 2013. The lab manual covers the fundamental information of the system configuration of mobile computing, set up, layout, interface design, other than individual topics in the mobile security. To avoid the large overlap with other mobile security, information security laboratories, the labs included in this version do not have basic areas of security engineering. 
As a new emerging research area in security engineering, mobile security and mobile computing knowledge faces a lot of unknown areas where the principles have not been studied and revealed. These undisclosed mysterious areas attract many researchers, educators and students to jump into the water and explore the wonder. In addition to cover the fundamental areas of mobile computing and security in this file, we also included the advanced topics of security, such as how to ensure the quality of mobile security under security concerns. This lab manual includes three sets of labs that cover fundamental knowledge of mobile computing, mobile security, and software testing on the mobile app. 
Currently there are seven units planned for this lab manual – environment set up, mobile computing, permission ID based system analysis, static analysis, dynamic analysis, and traffic engineering. Most of the labs are designed and developed in a finery way to show stepwise process to cover students’ background diversity. Each lab includes overview, objectives, descriptions. The lab is scalable and can be composed and integrated to large size to meet class requirements. This lab manual is developed based on review of several existing NSF fund project in this area.  
[bookmark: _Toc454951879]Features of This Manual
Several features of this developed manual are: 
1. This lab manual was developed in a cumulative style, from the fundamental knowledge to high level specific domain, from system and environment configuration to the program and design. 
2. This lab manual was developed to include some blank areas of mobile computing and mobile security that was not covered by many other labs, such as validation of cryptographic algorithm, specification based testing, and tools. 
3. This lab manual was self-contained in the content, which means you can find the information you need for your class and students from the beginning. 
4. This lab manual was user friendly, a large amount of screen shots are captured and included with a detailed step wised instruction. 
5. The labs in this manual was well designed that can be used in different level of curriculum from CS I to CS III, or senior level courses. 
[bookmark: _Toc454951880]Acknowledgement 
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[bookmark: _Toc454951881]Lab Unit I – System and Environment Set up
This lab unit is to introduce the IDE of Android – Android Studio bundle step by step.  
[bookmark: _Toc454951882]Lab 1.1. Android Studio Set Up
1.1.1. [bookmark: _Toc454951883]Lab Overview 
This lab is developed for students to be familiar with the Android development environment, SDK, ADT, SDK platforms and management. 
1.1.2. [bookmark: _Toc454951884]Objectives 
Be familiar with Android development environment. 
1.1.3. [bookmark: _Toc454951885]Lab Description 
Following is a step by step set up process for Adroid studio. 
1. Download Android Studio from http://developer.android.com/sdk/index.html
[image: ]
2. To start installing double-click on android-studio-bundle-141.2456560-windows.exe
[image: ]

3. Click Next to continue
4. Select Components to install and click Next
[image: ]
5. On License Agreement, Press Page Down to see the rest of the agreement and click I Agree
[image: ]

6. On Configuration Settings, select the installation location then click Next.
[image: ]
7. On Emulator Setup page, set the RAM as 2 GB as recommended, but if your machine has 6 GB or more RAM, you can set is as Custom for 3 GB.
[image: ]
8. Choose Start Menu Folder, leave it as Android Studio then click Install.
[image: ]
9. The installation process will begin.
[image: ]

[image: ]
10. Wait until the process is completed, then click Next
[image: ]
11. When Android Studio has been installed on your computer, click Finish to close Setup.
[image: ]
12. By default, the Android ADK does not include everything you need to start developing. The SDK separates tools, platforms, and other components into packages you can download as needed using the Android SDK Manager. So before you can start, there are a few packages you should add to your Android SDK.
[image: ]

[image: ]
13. On Android Studio, go to Tools -> Android -> SDK Manager
[image: ]
14. We need to set up the Android SDK Location:
[image: ]
15. Click Edit and locate the Android SDK, for example (C:\Users\WChoosilp\AppData\Local\Android\sdk), then click Next.
[image: ]
16. On SDK Setup window, click Next.
[image: ]

17. This will download and install the SDK Platform needed for Android Studio
[image: ]

18. After finished installing, click Finish to go back to SDK Manager window, then click OK.
[image: ]
19. Now, you would be able to start creating Android project on Android Studio which will be our next lab session.
[bookmark: _Toc454951886]Lab Unit II – Mobile Computing 
This lab unit focus on the app development of mobile computing which two aspects are covered – interface and layout development and the functional development. In addition, we will introduce database SQLite creation here. Three main apps were developed here – user log in process with SELite, personal contact list, and robot control layout. 
[bookmark: _Toc454951887]Lab Unit 2.1 Interface and Layout Design 
[bookmark: _Toc454951888]2.1.1 User Log In Process
Lab Overview
User log in process is one of the critical features of many apps. This lab aims at teaching how to build a user interface using Android layouts for all types of devices. The content includes fundamental steps of how to build a user interface using a flexible framework for GUI design and how to display different layouts for difference devices, how to create custom UI widgets, and control aspects of the system UI outside app’s window. 
Lab Objectives
The main objectives include following four items: 
· What are UI widgets that can be used for the interface design of Android apps
Lab Description 
In this lab, we are going to develop an Android application for login and registration screen with SQLite Database.  We will learn how to save application's data in its own Android SQLite Database.
Steps:
1. Start Android Studio and create a new project
Application name: 	AAMU Login and Registration
Company Domain: 	aamu.edu
Package name: 		edu.aamu.loginandregistration
[image: ]
2. On Target Android Devices, select Phone and Tablet and set Minimum SDK to API 15: Android 4.0.3 (IceCreamSandwich)
[image: ]
3. On Add an activity to Mobile, select Blank Activity
[image: ]
4. On Customize the Activity, leave everything as default.
[image: ]
5. Wait until Android Studio finish creating the project.
6. First, let copy A&M logo into the drawable directory
[image: ]
7. Open the content_main.xml file under layout directory and you should have the layout that looks like in the picture below.
[image: ]
8. Replace the contect_main.xml with this code:
	<RelativeLayout xmlns:android="http://schemas.android.com/apk/res/android"
    xmlns:tools="http://schemas.android.com/tools"
    android:layout_width="match_parent"
    android:layout_height="match_parent"
    android:gravity="center_vertical"
    android:orientation="vertical"
    android:weightSum="1"
    android:background="#8c0101">

    <ImageView
        android:id="@+id/imageView"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:layout_above="@+id/buttonSignIN"
        android:layout_alignParentEnd="true"
        android:layout_alignParentLeft="true"
        android:layout_alignParentRight="true"
        android:layout_alignParentStart="true"
        android:layout_alignParentTop="true"
        android:layout_gravity="center_horizontal"
        android:layout_weight="0.69"
        android:background="@drawable/aamu" />

    <Button
        android:id="@+id/buttonSignIN"
        android:layout_width="200dp"
        android:layout_height="wrap_content"
        android:layout_alignLeft="@+id/buttonSignUP"
        android:layout_alignParentBottom="true"
        android:layout_alignStart="@+id/buttonSignUP"
        android:layout_marginBottom="41dp"
        android:onClick="signIn"
        android:text="Sign In" />

    <Button
        android:id="@+id/buttonSignUP"
        android:layout_width="200dp"
        android:layout_height="wrap_content"
        android:layout_alignParentBottom="true"
        android:layout_centerHorizontal="true"
        android:text="Sign Up" />

</RelativeLayout>



9. Create a new layout file and name it layout_login.xml, then replace with this code:
	<?xml version="1.0" encoding="utf-8"?>
<RelativeLayout xmlns:android="http://schemas.android.com/apk/res/android"
    android:layout_width="wrap_content"
    android:layout_height="match_parent"
    android:orientation="vertical" >

    <EditText
        android:id="@+id/editTextUserNameToLogin"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:hint="User Name"
        android:ems="10"
        android:layout_marginTop="92dp"
        android:layout_below="@+id/imageView2"
        android:layout_centerHorizontal="true">
        <requestFocus />
    </EditText>

    <EditText
        android:id="@+id/editTextPasswordToLogin"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:ems="10"
        android:inputType="textPassword"
        android:hint="Password"
        android:layout_below="@+id/editTextUserNameToLogin"
        android:layout_centerHorizontal="true" />

    <Button
        android:id="@+id/buttonSignIn"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:text="Sign In"
        android:layout_below="@+id/editTextPasswordToLogin"
        android:layout_centerHorizontal="true" />

    <ImageView
        android:layout_width="match_parent"
        android:layout_height="wrap_content"
        android:id="@+id/imageView2"
        android:background="@drawable/aamu"
        android:layout_alignParentTop="true"
        android:layout_alignLeft="@+id/editTextUserNameToLogin"
        android:layout_alignStart="@+id/editTextUserNameToLogin" />

</RelativeLayout>



10. Create another layout and name it layout_signup.xml, then replace with this code:
	<?xml version="1.0" encoding="utf-8"?>
<RelativeLayout xmlns:android="http://schemas.android.com/apk/res/android"
    android:layout_width="match_parent"
    android:layout_height="match_parent"
    android:orientation="vertical"
    android:gravity="center_vertical" >

    <EditText
        android:id="@+id/editTextUserName"
        android:hint="User Name"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:layout_above="@+id/editTextPassword"
        android:layout_alignLeft="@+id/editTextPassword"
        android:layout_alignStart="@+id/editTextPassword"
        android:layout_alignRight="@+id/editTextPassword"
        android:layout_alignEnd="@+id/editTextPassword">

        <requestFocus />
    </EditText>

    <EditText
        android:id="@+id/editTextPassword"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:hint="Password"
        android:inputType="textPassword"
        android:layout_centerVertical="true"
        android:layout_alignLeft="@+id/editTextConfirmPassword"
        android:layout_alignStart="@+id/editTextConfirmPassword"
        android:layout_alignRight="@+id/editTextConfirmPassword"
        android:layout_alignEnd="@+id/editTextConfirmPassword" />

    <EditText
        android:id="@+id/editTextConfirmPassword"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:hint="Confirm Password"
        android:inputType="textPassword"
        android:layout_below="@+id/editTextPassword"
        android:layout_centerHorizontal="true" />

    <Button
        android:id="@+id/buttonCreateAccount"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:text="Create Account"
        android:layout_above="@+id/btnBack"
        android:layout_alignLeft="@+id/editTextConfirmPassword"
        android:layout_alignStart="@+id/editTextConfirmPassword"
        android:layout_alignRight="@+id/editTextConfirmPassword"
        android:layout_alignEnd="@+id/editTextConfirmPassword" />

    <Button
        android:id="@+id/btnBack"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:text="Back to Sign In"
        android:layout_alignParentBottom="true"
        android:layout_alignLeft="@+id/buttonCreateAccount"
        android:layout_alignStart="@+id/buttonCreateAccount"
        android:layout_alignRight="@+id/buttonCreateAccount"
        android:layout_alignEnd="@+id/buttonCreateAccount" />

</RelativeLayout>



11. Create another layout and name it layout_login_successful.xml, then replay with the code:
	<?xml version="1.0" encoding="utf-8"?>
<RelativeLayout xmlns:android="http://schemas.android.com/apk/res/android"
    android:layout_width="match_parent"
    android:layout_height="match_parent">

    <TextView
        android:layout_width="match_parent"
        android:layout_height="wrap_content"
        android:textAppearance="?android:attr/textAppearanceLarge"
        android:text="You are successfully logged in"
        android:id="@+id/textView"
        android:textAlignment="center"
        android:textColor="#1152f7"
        android:layout_alignParentTop="true"
        android:layout_alignParentLeft="true"
        android:layout_alignParentStart="true"
        android:layout_marginTop="138dp" />

    <Button
        style="?android:attr/buttonStyleSmall"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:text="Sign Out"
        android:id="@+id/btnSignOut"
        android:layout_centerVertical="true"
        android:layout_centerHorizontal="true" />
</RelativeLayout>



12. Now, let's create the java class under the package (edu.aamu.loginandregistration).  For MainActivity.java, replace with this code:
	package edu.aamu.loginandregistration;

import android.app.Activity;
import android.app.Dialog;
import android.content.Intent;
import android.os.Bundle;
import android.view.View;
import android.widget.Button;
import android.widget.EditText;
import android.widget.Toast;

public class MainActivity extends Activity {
    Button btnSignIn, btnSignUp;
    LoginDataBaseAdapter loginDataBaseAdapter;

    @Override
    protected void onCreate(Bundle savedInstanceState) {
        super.onCreate(savedInstanceState);
        setContentView(R.layout.activity_main);

        // create a instance of SQLite Database
        loginDataBaseAdapter = new LoginDataBaseAdapter(this);
        loginDataBaseAdapter = loginDataBaseAdapter.open();

        // Get The Refference Of Buttons
        btnSignIn = (Button) findViewById(R.id.buttonSignIN);
        btnSignUp = (Button) findViewById(R.id.buttonSignUP);

        // Set OnClick Listener on SignUp button
        btnSignUp.setOnClickListener(new View.OnClickListener() {
            public void onClick(View v) {
                // TODO Auto-generated method stub

                /// Create Intent for SignUpActivity  abd Start The Activity
                Intent intentSignUP = new Intent(getApplicationContext(), SignUpActivity.class);
                startActivity(intentSignUP);
            }
        });
    }

    // Methos to handleClick Event of Sign In Button
    public void signIn(View V) {
        final Dialog dialog = new Dialog(MainActivity.this);
        dialog.setContentView(R.layout.layout_login);
        dialog.setTitle("Login");

        // get the Refferences of views
        final EditText editTextUserName = (EditText) dialog.findViewById(R.id.editTextUserNameToLogin);
        final EditText editTextPassword = (EditText) dialog.findViewById(R.id.editTextPasswordToLogin);

        Button btnSignIn = (Button) dialog.findViewById(R.id.buttonSignIn);

        // Set On ClickListener
        btnSignIn.setOnClickListener(new View.OnClickListener() {

            public void onClick(View v) {
                // get The User name and Password
                String userName = editTextUserName.getText().toString();
                String password = editTextPassword.getText().toString();

                // fetch the Password form database for respective user name
                String storedPassword = loginDataBaseAdapter.getSinlgeEntry(userName);

                // check if the Stored password matches with  Password entered by user
                if (password.equals(storedPassword)) {
                    Toast.makeText(MainActivity.this, "Congrats: Login Successfull", Toast.LENGTH_LONG).show();
                    startActivity(new Intent(MainActivity.this, LoginSuccessfulActivity.class));
                    dialog.dismiss();
                } else {
                    Toast.makeText(MainActivity.this, "User Name or Password does not match", Toast.LENGTH_LONG).show();
                }
            }
        });

        dialog.show();
    }

    @Override
    protected void onDestroy() {
        super.onDestroy();
        // Close The Database
        loginDataBaseAdapter.close();
    }
}



13. Let's create another class and name it SignUpActivity.java, then replace with this code:
	package edu.aamu.loginandregistration;

import android.app.Activity;
import android.content.Intent;
import android.os.Bundle;
import android.view.View;
import android.widget.Button;
import android.widget.EditText;
import android.widget.Toast;

/**
 * Created by WChoosilp on 1/8/2016.
 */

public class SignUpActivity extends Activity {
    EditText editTextUserName, editTextPassword, editTextConfirmPassword;
    Button btnCreateAccount;
    Button btnBack;

    LoginDataBaseAdapter loginDataBaseAdapter;

    @Override
    protected void onCreate(Bundle savedInstanceState) {
        super.onCreate(savedInstanceState);
        setContentView(R.layout.layout_signup);

        // get Instance  of Database Adapter
        loginDataBaseAdapter = new LoginDataBaseAdapter(this);
        loginDataBaseAdapter = loginDataBaseAdapter.open();

        // Get References of Views
        editTextUserName = (EditText) findViewById(R.id.editTextUserName);
        editTextPassword = (EditText) findViewById(R.id.editTextPassword);
        editTextConfirmPassword = (EditText) findViewById(R.id.editTextConfirmPassword);

        btnBack = (Button) findViewById(R.id.btnBack);
        btnBack.setOnClickListener(new View.OnClickListener() {
            public void onClick(View v) {
                Toast.makeText(SignUpActivity.this, "Back to Sign In", Toast.LENGTH_SHORT).show();
                startActivity(new Intent(SignUpActivity.this, MainActivity.class));
            }
        });

        btnCreateAccount = (Button) findViewById(R.id.buttonCreateAccount);
        btnCreateAccount.setOnClickListener(new View.OnClickListener() {

            public void onClick(View v) {
                // TODO Auto-generated method stub

                String userName = editTextUserName.getText().toString();
                String password = editTextPassword.getText().toString();
                String confirmPassword = editTextConfirmPassword.getText().toString();

                // check if any of the fields are vacant
                if (userName.equals("") || password.equals("") || confirmPassword.equals("")) {
                    Toast.makeText(getApplicationContext(), "Please fill in username and password.", Toast.LENGTH_LONG).show();
                    return;
                }
                // check if both password matches
                if (!password.equals(confirmPassword)) {
                    Toast.makeText(getApplicationContext(), "Password does not match, please try again.", Toast.LENGTH_LONG).show();
                    return;
                } else {
                    // Save the Data in Database
                    loginDataBaseAdapter.insertEntry(userName, password);
                    Toast.makeText(getApplicationContext(), "Account Successfully Created!", Toast.LENGTH_LONG).show();
                }
            }
        });
    }

    @Override
    protected void onDestroy() {
        // TODO Auto-generated method stub
        super.onDestroy();

        loginDataBaseAdapter.close();
    }
}



14. Create another class and name it DataBaseHelper.java, then replace with this code:
	package edu.aamu.loginandregistration;

import android.content.Context;
import android.database.sqlite.SQLiteDatabase;
import android.database.sqlite.SQLiteDatabase.CursorFactory;
import android.database.sqlite.SQLiteOpenHelper;
import android.util.Log;

/**
 * Created by WChoosilp on 1/8/2016.
 */

public class DataBaseHelper extends SQLiteOpenHelper {
    public DataBaseHelper(Context context, String name, CursorFactory factory, int version) {
        super(context, name, factory, version);
    }

    // Called when no database exists in disk and the helper class needs
    // to create a new one.
    @Override
    public void onCreate(SQLiteDatabase _db) {
        _db.execSQL(LoginDataBaseAdapter.DATABASE_CREATE);

    }

    // Called when there is a database version mismatch meaning that the version
    // of the database on disk needs to be upgraded to the current version.
    @Override
    public void onUpgrade(SQLiteDatabase _db, int _oldVersion, int _newVersion) {
        // Log the version upgrade.
        Log.w("TaskDBAdapter", "Upgrading from version " + _oldVersion + " to " + _newVersion + ", which will destroy all old data");

        // Upgrade the existing database to conform to the new version. Multiple
        // previous versions can be handled by comparing _oldVersion and _newVersion
        // values.
        // The simplest case is to drop the old table and create a new one.
        _db.execSQL("DROP TABLE IF EXISTS " + "TEMPLATE");
        // Create a new one.
        onCreate(_db);
    }

}



15. Create another class and name it LoginDataBaseAdapter.java, then replace with this code:
	package edu.aamu.loginandregistration;

import android.content.ContentValues;
import android.content.Context;
import android.database.Cursor;
import android.database.SQLException;
import android.database.sqlite.SQLiteDatabase;

/**
 * Created by WChoosilp on 1/8/2016.
 */

public class LoginDataBaseAdapter {
    static final String DATABASE_NAME = "login.db";
    static final int DATABASE_VERSION = 1;
    public static final int NAME_COLUMN = 1;
    // TODO: Create public field for each column in your table.
    // SQL Statement to create a new database.
    static final String DATABASE_CREATE = "create table " + "LOGIN" +
            "( " + "ID" + " integer primary key autoincrement," + "USERNAME  text,PASSWORD text); ";
    // Variable to hold the database instance
    public SQLiteDatabase db;
    // Context of the application using the database.
    private final Context context;
    // Database open/upgrade helper
    private DataBaseHelper dbHelper;

    public LoginDataBaseAdapter(Context _context) {
        context = _context;
        dbHelper = new DataBaseHelper(context, DATABASE_NAME, null, DATABASE_VERSION);
    }

    public LoginDataBaseAdapter open() throws SQLException {
        db = dbHelper.getWritableDatabase();
        return this;
    }

    public void close() {
        db.close();
    }

    public SQLiteDatabase getDatabaseInstance() {
        return db;
    }

    public void insertEntry(String userName, String password) {
        ContentValues newValues = new ContentValues();
        // Assign values for each row.
        newValues.put("USERNAME", userName);
        newValues.put("PASSWORD", password);

        // Insert the row into your table
        db.insert("LOGIN", null, newValues);
        ///Toast.makeText(context, "Reminder Is Successfully Saved", Toast.LENGTH_LONG).show();
    }

    public int deleteEntry(String UserName) {
        //String id=String.valueOf(ID);
        String where = "USERNAME=?";
        int numberOFEntriesDeleted = db.delete("LOGIN", where, new String[]{UserName});
        // Toast.makeText(context, "Number fo Entry Deleted Successfully : "+numberOFEntriesDeleted, Toast.LENGTH_LONG).show();
        return numberOFEntriesDeleted;
    }

    public String getSinlgeEntry(String userName) {
        Cursor cursor = db.query("LOGIN", null, " USERNAME=?", new String[]{userName}, null, null, null);
        if (cursor.getCount() < 1) // UserName Not Exist
        {
            cursor.close();
            return "NOT EXIST";
        }
        cursor.moveToFirst();
        String password = cursor.getString(cursor.getColumnIndex("PASSWORD"));
        cursor.close();
        return password;
    }

    public void updateEntry(String userName, String password) {
        // Define the updated row content.
        ContentValues updatedValues = new ContentValues();
        // Assign values for each row.
        updatedValues.put("USERNAME", userName);
        updatedValues.put("PASSWORD", password);

        String where = "USERNAME = ?";
        db.update("LOGIN", updatedValues, where, new String[]{userName});
    }
}



16. Now, create one last class and name it LoginSuccessfulActivity.java, then replace with this code:
	package edu.aamu.loginandregistration;

import android.app.Activity;
import android.os.Bundle;
import android.view.View;
import android.widget.Button;
import android.widget.Toast;

/**
 * Created by WChoosilp on 1/8/2016.
 */
public class LoginSuccessfulActivity extends Activity {

    Button signOut;

    @Override
    protected void onCreate(Bundle savedInstanceState) {
        super.onCreate(savedInstanceState);
        setContentView(R.layout.layout_login_successful);

        signOut = (Button) findViewById(R.id.btnSignOut);
        signOut.setOnClickListener(new View.OnClickListener() {
            @Override
            public void onClick(View v) {
                Toast.makeText(LoginSuccessfulActivity.this, "You are signing out and application is closed now.", Toast.LENGTH_LONG).show();
                android.os.Process.killProcess(android.os.Process.myPid());
                System.exit(1);
            }
        });
    }
}



17. We are now can run the application and if there is no error, we should see the application runs with the first screen.
[image: ]
18. Tab on Sign Up button, the application will open a sign up screen.
[image: ]
19. Let's try to create new account, for 
User Name: 	user
Password:	 user
[image: ]
20. Now, tab on Back to Sign In button, and let try to Sign In with the account that we just created.
[image: ]
21. The application should open the Login Successful screen.
[image: ]


[bookmark: _Toc454951889]2.1.2 Contact Information App
Lab Overview
This lab aims at teaching how to build a user interface using Android layouts for all types of devices. The content includes fundamental steps of how to build a user interface using a flexible framework for GUI design and how to display different layouts for difference devices, how to create custom UI widgets, and control aspects of the system UI outside app’s window. 
Lab Objectives
The main objectives include following four items: 
· What are UI widgets that can be used for the interface design of Android apps
· How to build a simple UI design 
· How to support different size of screen
· Hot to create different interaction patterns that are optimized for different size of screen
Lab Description 
Steps:
1. Start Android Studio and create a new project
Application name:	 AAMU Contacts
Company Domain: 	aamu.edu
Package name: 		edu.aamu.contacts
[image: ]



2. On the Target Android Devices, check the Phone and Tablet and set the Minimum SDK to API 15: Android 4.0.3 (IceCreamSandwich)
[image: ]

3. On Add an activity to Mobile, select Blank Activity and click Next
[image: ]

4. On Customize the Activity window, just leave it as default and click Finish.
[image: ]

5. Wait until Android Studio finished building the project and Android Studio should look like the picture below.
[image: ]



6. First, let's copy the aamu.png and ic_launcher.png files into the drawable resource directory
[image: ]
7. Now, let's create all of the layouts needed for this project:
· layout_main.xml	- Android Studio already created it
· layout_content.xml	- Android Studio already created it
· layout_edit.xml
· layout_listview.xml
· layout_login.xml
· layout_splash.xml
8. We should not have to make any change for layout_main.xml and it should look like this:
	<?xml version="1.0" encoding="utf-8"?>
<android.support.design.widget.CoordinatorLayout xmlns:android="http://schemas.android.com/apk/res/android"
    xmlns:app="http://schemas.android.com/apk/res-auto"
    xmlns:tools="http://schemas.android.com/tools"
    android:layout_width="match_parent"
    android:layout_height="match_parent"
    android:fitsSystemWindows="true"
    tools:context="edu.aamu.contacts.MainActivity">

    <android.support.design.widget.AppBarLayout
        android:layout_width="match_parent"
        android:layout_height="wrap_content"
        android:theme="@style/AppTheme.AppBarOverlay">

        <android.support.v7.widget.Toolbar
            android:id="@+id/toolbar"
            android:layout_width="match_parent"
            android:layout_height="?attr/actionBarSize"
            android:background="?attr/colorPrimary"
            app:popupTheme="@style/AppTheme.PopupOverlay" />

    </android.support.design.widget.AppBarLayout>

    <include layout="@layout/content_main" />

    <android.support.design.widget.FloatingActionButton
        android:id="@+id/fab"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:layout_gravity="bottom|end"
        android:layout_margin="@dimen/fab_margin"
        android:src="@android:drawable/ic_dialog_email" />

</android.support.design.widget.CoordinatorLayout>



9. For content_layout.xml, add this code:
	<?xml version="1.0" encoding="utf-8"?>
<LinearLayout xmlns:android="http://schemas.android.com/apk/res/android"
    android:layout_width="wrap_content"
    android:layout_height="wrap_content"
    android:orientation="vertical"
    android:background="#610101">

    <ImageView
        android:layout_width="81dp"
        android:layout_height="81dp"
        android:id="@+id/imageView"
        android:layout_gravity="center_horizontal"
        android:background="@drawable/aamu" />

    <Button
        style="?android:attr/buttonStyleSmall"
        android:id="@+id/btnAdd"
        android:layout_width="match_parent"
        android:layout_height="wrap_content"
        android:hint="Add"
        android:text="Add New Contact" />

    <ListView
        android:id="@+id/listView"
        android:layout_width="wrap_content"
        android:layout_height="match_parent"
        android:layout_gravity="fill_vertical"
        android:layout_margin="2dp" >

    </ListView>

</LinearLayout>



10. For layout_edit.xml, add this code:
	<LinearLayout xmlns:android="http://schemas.android.com/apk/res/android"
    xmlns:tools="http://schemas.android.com/tools"
    android:layout_width="match_parent"
    android:layout_height="match_parent"
    android:orientation="vertical"
    android:padding="5dp"
    android:background="#610101">
    android:layout_width="match_parent"
    android:layout_height="wrap_content" >

    <ImageView
        android:id="@+id/imageView1"
        android:layout_width="81dp"
        android:layout_height="81dp"
        android:layout_gravity="center"
        android:src="@drawable/aamu" />

    <EditText
        android:id="@+id/frst_editTxt"
        android:layout_width="match_parent"
        android:layout_height="wrap_content"
        android:ems="10"
        android:hint="Name" >

        <requestFocus />
    </EditText>

    android:layout_width="match_parent"
    android:layout_height="wrap_content" >

    android:layout_width="match_parent"
    android:layout_height="wrap_content" >

    <EditText
        android:id="@+id/email_editTxt"
        android:layout_width="fill_parent"
        android:layout_height="wrap_content"
        android:layout_marginTop="10dp"
        android:layout_toRightOf="@+id/email_txtV"
        android:hint="Email Address" />

    android:layout_width="match_parent"
    android:layout_height="wrap_content" >

    <EditText
        android:id="@+id/phone_editTxt"
        android:layout_width="fill_parent"
        android:layout_height="wrap_content"
        android:layout_marginTop="10dp"
        android:layout_toRightOf="@+id/phone_txtV"
        android:hint="Phone Number" />

    android:layout_width="match_parent"
    android:layout_height="wrap_content" >

    <EditText
        android:id="@+id/officeN_editTxt"
        android:layout_width="fill_parent"
        android:layout_height="wrap_content"
        android:layout_marginTop="10dp"
        android:layout_toRightOf="@+id/officeN_txtV"
        android:hint="Office Number" />

    android:layout_width="match_parent"
    android:layout_height="wrap_content" >

    <EditText
        android:id="@+id/officeH_editTxt"
        android:layout_width="fill_parent"
        android:layout_height="wrap_content"
        android:layout_marginTop="10dp"
        android:layout_toRightOf="@+id/officeH_txtV"
        android:hint="Office Hours" />

    <Button
        style="?android:attr/buttonStyleSmall"
        android:id="@+id/save_btn"
        android:layout_width="95dp"
        android:layout_height="wrap_content"
        android:layout_gravity="right"
        android:layout_marginTop="10dp"
        android:text="Save"
        android:textColor="#000" />

    <Button
        style="?android:attr/buttonStyleSmall"
        android:layout_width="95dp"
        android:layout_height="wrap_content"
        android:text="Cancel"
        android:id="@+id/cancel_btn"
        android:layout_marginTop="10dp"
        android:textColor="#000"
        android:layout_gravity="right" />

</LinearLayout>



11. For layout_listview.xml, add this code:
	<LinearLayout xmlns:android="http://schemas.android.com/apk/res/android"
    xmlns:tools="http://schemas.android.com/tools"
    android:layout_width="match_parent"
    android:layout_height="match_parent"
    android:background="#610101"
    android:gravity="center_vertical"
    android:orientation="horizontal"
    android:padding="8dp" >

    <TextView
        android:id="@+id/txt_id"
        android:layout_width="0dp"
        android:layout_height="wrap_content"
        android:layout_weight="1"
        android:textColor="#000" />

    <TextView
        android:id="@+id/txt_fName"
        android:layout_width="0dp"
        android:layout_height="wrap_content"
        android:layout_weight="2"
        android:textColor="#000" />

    <TextView
        android:id="@+id/txt_lName"
        android:layout_width="0dp"
        android:layout_height="wrap_content"
        android:layout_weight="2"
        android:textColor="#000" />

    <TextView
        android:id="@+id/txt_eAddress"
        android:layout_width="0dp"
        android:layout_height="wrap_content"
        android:layout_weight="2"
        android:textColor="#000" />

    <TextView
        android:id="@+id/txt_pNumber"
        android:layout_width="0dp"
        android:layout_height="wrap_content"
        android:layout_weight="2"
        android:textColor="#000" />

    <TextView
        android:id="@+id/txt_oNumber"
        android:layout_width="0dp"
        android:layout_height="wrap_content"
        android:layout_weight="2"
        android:textColor="#000" />

    <TextView
        android:id="@+id/txt_oHours"
        android:layout_width="0dp"
        android:layout_height="wrap_content"
        android:layout_weight="2"
        android:textColor="#000" />


</LinearLayout>



12. For layout_login.xml, add this code:
	<?xml version="1.0" encoding="utf-8"?>
<ScrollView xmlns:android="http://schemas.android.com/apk/res/android"
    android:layout_width="fill_parent"
    android:layout_height="fill_parent"
    android:fillViewport="true" >

    <RelativeLayout
        android:background="#610101"
        android:layout_width="fill_parent"
        android:layout_height="wrap_content" >

        <!-- Logo Start -->
        <ImageView
            android:id="@+id/logo"
            android:layout_width="wrap_content"
            android:layout_height="wrap_content"
            android:layout_centerHorizontal="true"
            android:src="@drawable/ic_launcher" />
        <!-- Place your company logo in the src attribute -->
        <!-- Logo Ends -->


        <!-- Login Form -->

        <LinearLayout
            android:layout_width="match_parent"
            android:layout_height="wrap_content"
            android:layout_below="@id/logo"
            android:orientation="vertical"
            android:padding="10dip"
            android:id="@+id/linearLayout">

            <!-- Username Label -->
            <TextView
                android:layout_width="fill_parent"
                android:layout_height="wrap_content"
                android:text="Username" />

            <EditText
                android:id="@+id/etUsername"
                android:layout_width="fill_parent"
                android:layout_height="wrap_content"
                android:layout_marginBottom="20dip"
                android:layout_marginTop="5dip"
                android:singleLine="true" />

            <!-- Password Label -->
            <TextView
                android:layout_width="fill_parent"
                android:layout_height="wrap_content"
                android:text="Password" />

            <EditText
                android:id="@+id/etPassword"
                android:layout_width="fill_parent"
                android:layout_height="wrap_content"
                android:layout_marginTop="5dip"
                android:password="true"
                android:singleLine="true" />

            <!-- Login button -->
            <Button
                style="?android:attr/buttonStyleSmall"
                android:id="@+id/btnLogin"
                android:layout_width="fill_parent"
                android:layout_height="wrap_content"
                android:layout_marginTop="10dip"
                android:text="Login" />
        </LinearLayout>

        <ImageView
            android:layout_width="wrap_content"
            android:layout_height="wrap_content"
            android:id="@+id/imageView2"
            android:background="@drawable/aamu"
            android:layout_alignParentBottom="true"
            android:layout_centerHorizontal="true" />

        <TextView
            android:layout_width="match_parent"
            android:layout_height="wrap_content"
            android:textAppearance="?android:attr/textAppearanceLarge"
            android:text="Start Here - Go Anywhere"
            android:id="@+id/textView"
            android:layout_below="@+id/linearLayout"
            android:layout_alignLeft="@+id/imageView2"
            android:layout_alignStart="@+id/imageView2"
            android:layout_alignParentRight="true"
            android:layout_alignParentEnd="true" />
        <!-- Login Form Ends -->

    </RelativeLayout>

</ScrollView>



13. For layout_splash.xml, add this code:
	<FrameLayout xmlns:android="http://schemas.android.com/apk/res/android"
    xmlns:tools="http://schemas.android.com/tools"
    android:id="@+id/container"
    android:layout_width="match_parent"
    android:layout_height="match_parent"
    tools:context="com.aamucontacts.SplashActivity"
    android:background="#610101"
    tools:ignore="MergeRootFrame" >

    <ImageView
        android:id="@+id/imageView1"
        android:layout_width="363dp"
        android:layout_height="363dp"
        android:src="@drawable/aamu"
        android:layout_gravity="center" />

    <ProgressBar
        android:layout_width="183dp"
        android:layout_height="183dp"
        android:id="@+id/progressBar"
        android:layout_gravity="center" />
</FrameLayout>



14. In the menu resource directory, create a new .xml file and named it display_contact.xml
	<menu xmlns:android="http://schemas.android.com/apk/res/android" >
    <item
        android:id="@+id/Edit_Contact"
        android:orderInCategory="100"
        android:title="@string/edit"/>

    <item
        android:id="@+id/Delete_Contact"
        android:orderInCategory="100"
        android:title="@string/delete"/>
</menu>




15. In the values resource directory, open the strings.xml file and add this code:
	<?xml version="1.0" encoding="utf-8"?>
<resources>
    <string name="app_name">AAMU Contacts</string>
    <string name="action_settings">Settings</string>
    <string name="hello_world">Hello world!</string>
    <string name="Add_New">Add New Contact</string>
    <string name="edit">Edit Contact</string>
    <string name="delete">Delete Contact</string>
    <string name="title_activity_display_contact">Display Contact</string>
    <string name="name">Name:</string>
    <string name="phone">Phone:</string>
    <string name="email">Email:</string>
    <string name="street">Street:</string>
    <string name="country">City/State/Zip:</string>
    <string name="save">Save Contact</string>
    <string name="deleteContact">Are you sure, you want to delete this contact?</string>
    <string name="yes">Yes</string>
    <string name="no">No</string>
</resources>



16. Now, on Android directory, it should have these files as you see in the picture.
[image: ]
17. Now, let's create the source code files in the package directory (edu.aamu.contacts)
We need to create these classes:
· MainActivity.java
· DBAdapter.java
· DBHelper.java
· EditActivity.java
· LoginActivity.java
· SplashActivity.java
18. For the MainActivity.java, add this code:
	package edu.aamu.contacts;

import java.util.ArrayList;

import android.app.Activity;
import android.app.AlertDialog;
import android.content.DialogInterface;
import android.content.Intent;
import android.database.Cursor;
import android.database.sqlite.SQLiteDatabase;
import android.os.Bundle;
import android.view.View;
import android.view.View.OnClickListener;
import android.widget.AdapterView;
import android.widget.AdapterView.OnItemClickListener;
import android.widget.AdapterView.OnItemLongClickListener;
import android.widget.ListView;
import android.widget.Toast;

/**
 * Created by WChoosilp on 1/6/2016.
 */
public class MainActivity extends Activity {

    private DBHelper mHelper;
    private SQLiteDatabase dataBase;

    private ArrayList<String> userId = new ArrayList<String>();
    private ArrayList<String> user_fName = new ArrayList<String>();
    private ArrayList<String> user_eAddress = new ArrayList<String>();
    private ArrayList<String> user_pNumber = new ArrayList<String>();
    private ArrayList<String> user_oNumber = new ArrayList<String>();
    private ArrayList<String> user_oHours = new ArrayList<String>();

    private ListView userList;
    private AlertDialog.Builder build;

    @Override
    protected void onCreate(Bundle savedInstanceState) {
        super.onCreate(savedInstanceState);
        setContentView(R.layout.content_main);

        userList = (ListView) findViewById(R.id.listView);
        mHelper = new DBHelper(this);

        // add new record
        findViewById(R.id.btnAdd).setOnClickListener(new OnClickListener() {

            @Override
            public void onClick(View arg0) {
                // TODO Auto-generated method stub
                Intent i = new Intent(getApplicationContext(),
                        EditActivity.class);
                i.putExtra("update", false);
                startActivity(i);
            }
        });

        // click to update data
        userList.setOnItemClickListener(new OnItemClickListener() {

            public void onItemClick(AdapterView<?> arg0, View arg1, int arg2,
                                    long arg3) {

                Intent i = new Intent(getApplicationContext(),
                        EditActivity.class);
                i.putExtra("Fname", user_fName.get(arg2));
                i.putExtra("Eaddress", user_eAddress.get(arg2));
                i.putExtra("Pnumber", user_pNumber.get(arg2));
                i.putExtra("Onumber", user_oNumber.get(arg2));
                i.putExtra("Ohours", user_oHours.get(arg2));
                i.putExtra("ID", userId.get(arg2));
                i.putExtra("update", true);
                startActivity(i);
            }
        });

        // long click to delete data
        userList.setOnItemLongClickListener(new OnItemLongClickListener() {

            public boolean onItemLongClick(AdapterView<?> arg0, View arg1,
                                           final int arg2, long arg3) {

                build = new AlertDialog.Builder(MainActivity.this);
                build.setTitle("Delete " + user_fName.get(arg2)/* + " " + " "
                        + user_eAddress.get(arg2) + " "
                        + user_pNumber.get(arg2) + " " + user_oNumber.get(arg2)
                        + " " + user_oHours.get(arg2)*/);
                build.setMessage("Do you want to delete this contact?");
                build.setPositiveButton("Yes",
                        new DialogInterface.OnClickListener() {

                            public void onClick(DialogInterface dialog,
                                                int which) {

                                Toast.makeText(
                                        getApplicationContext(),
                                        user_fName.get(arg2) + " " + " "
                                                + user_eAddress.get(arg2) + " "
/*                                                + user_pNumber.get(arg2) + " "
                                                + user_oNumber.get(arg2) + " "
                                                + user_oHours.get(arg2)*/
                                                + " is deleted.", Toast.LENGTH_SHORT).show();

                                dataBase.delete(
                                        DBHelper.TABLE_NAME,
                                        DBHelper.KEY_ID + "="
                                                + userId.get(arg2), null);
                                displayData();
                                dialog.cancel();
                            }
                        });

                build.setNegativeButton("No",
                        new DialogInterface.OnClickListener() {

                            public void onClick(DialogInterface dialog,
                                                int which) {
                                dialog.cancel();
                            }
                        });
                AlertDialog alert = build.create();
                alert.show();

                return true;
            }
        });
    }

    @Override
    protected void onResume() {
        displayData();
        super.onResume();
    }

    /**
     * displays data from SQLite
     */
    private void displayData() {
        dataBase = mHelper.getWritableDatabase();
        Cursor mCursor = dataBase.rawQuery("SELECT * FROM "
                + DBHelper.TABLE_NAME, null);

        userId.clear();
        user_fName.clear();
        user_eAddress.clear();
        user_pNumber.clear();
        user_oNumber.clear();
        user_oHours.clear();
        if (mCursor.moveToFirst()) {
            do {
                userId.add(mCursor.getString(mCursor
                        .getColumnIndex(DBHelper.KEY_ID)));
                user_fName.add(mCursor.getString(mCursor
                        .getColumnIndex(DBHelper.KEY_FNAME)));
                user_eAddress.add(mCursor.getString(mCursor
                        .getColumnIndex(DBHelper.KEY_EADDRESS)));
                user_pNumber.add(mCursor.getString(mCursor
                        .getColumnIndex(DBHelper.KEY_PNUMBER)));
                user_oNumber.add(mCursor.getString(mCursor
                        .getColumnIndex(DBHelper.KEY_ONUMBER)));
                user_oHours.add(mCursor.getString(mCursor
                        .getColumnIndex(DBHelper.KEY_OHOURS)));

            } while (mCursor.moveToNext());
        }
        DBAdapter adapter = new DBAdapter(MainActivity.this, userId,
                user_fName, user_eAddress, user_pNumber, user_oNumber,
                user_oHours);
        userList.setAdapter(adapter);
        mCursor.close();
    }
}



19. For DBAdapter.java, add this code:
	package edu.aamu.contacts;

import java.util.ArrayList;

import android.content.Context;
import android.view.LayoutInflater;
import android.view.View;
import android.view.ViewGroup;
import android.widget.BaseAdapter;
import android.widget.TextView;

/**
 * Created by WChoosilp on 1/7/2016.
 */
public class DBAdapter extends BaseAdapter {
    private Context mContext;
    private ArrayList<String> id;
    private ArrayList<String> firstName;
    private ArrayList<String> emailAddress;
    private ArrayList<String> phoneNumber;
    private ArrayList<String> officeNumber;
    private ArrayList<String> officeHours;

    public DBAdapter(Context c, ArrayList<String> id, ArrayList<String> fname,
                     ArrayList<String> eaddress, ArrayList<String> pnumber,
                     ArrayList<String> onumber, ArrayList<String> ohours) {
        this.mContext = c;

        this.id = id;
        this.firstName = fname;
        this.emailAddress = eaddress;
        this.phoneNumber = pnumber;
        this.officeNumber = onumber;
        this.officeHours = ohours;
    }

    public int getCount() {
        return id.size();
    }

    public Object getItem(int position) {
        return null;
    }

    public long getItemId(int position) {
        return 0;
    }

    public View getView(int pos, View child, ViewGroup parent) {
        Holder mHolder;
        LayoutInflater layoutInflater;
        if (child == null) {
            layoutInflater = (LayoutInflater) mContext.getSystemService(Context.LAYOUT_INFLATER_SERVICE);
            child = layoutInflater.inflate(R.layout.layout_listview, null);
            mHolder = new Holder();
            mHolder.txt_id = (TextView) child.findViewById(R.id.txt_id);
            mHolder.txt_fName = (TextView) child.findViewById(R.id.txt_fName);
            mHolder.txt_eAddress = (TextView) child.findViewById(R.id.txt_eAddress);
            mHolder.txt_pNumber = (TextView) child.findViewById(R.id.txt_pNumber);
            mHolder.txt_oNumber = (TextView) child.findViewById(R.id.txt_oNumber);
            mHolder.txt_oHours = (TextView) child.findViewById(R.id.txt_oHours);
            child.setTag(mHolder);
        } else {
            mHolder = (Holder) child.getTag();
        }
        mHolder.txt_id.setText(id.get(pos));
        mHolder.txt_fName.setText(firstName.get(pos));
        mHolder.txt_eAddress.setText(emailAddress.get(pos));
        mHolder.txt_pNumber.setText(phoneNumber.get(pos));
        mHolder.txt_oNumber.setText(officeNumber.get(pos));
        mHolder.txt_oHours.setText(officeHours.get(pos));

        return child;
    }

    public class Holder {
        TextView txt_id;
        TextView txt_fName;
        TextView txt_eAddress;
        TextView txt_pNumber;
        TextView txt_oNumber;
        TextView txt_oHours;
    }
}



20. For DBHelper.java, add this code:
	package edu.aamu.contacts;

import android.content.Context;
import android.database.sqlite.SQLiteDatabase;
import android.database.sqlite.SQLiteOpenHelper;

/**
 * Created by WChoosilp on 1/7/2016.
 */
public class DBHelper extends SQLiteOpenHelper {
    static String DATABASE_NAME = "userdata";
    public static final String TABLE_NAME = "user";
    public static final String KEY_FNAME = "fname";
    public static final String KEY_EADDRESS = "eaddress";
    public static final String KEY_PNUMBER = "pnumber";
    public static final String KEY_ONUMBER = "onumber";
    public static final String KEY_OHOURS = "ohours";
    public static final String KEY_ID = "id";

    public DBHelper(Context context) {
        super(context, DATABASE_NAME, null, 1);
    }

    @Override
    public void onCreate(SQLiteDatabase db) {
        String CREATE_TABLE = "CREATE TABLE " + TABLE_NAME + " (" + KEY_ID + " INTEGER PRIMARY KEY, "
                + KEY_FNAME + " TEXT, " + KEY_EADDRESS + " TEXT, " + KEY_PNUMBER + " TEXT, "
                + KEY_ONUMBER + " TEXT, " + KEY_OHOURS + " TEXT)";
        db.execSQL(CREATE_TABLE);
    }

    @Override
    public void onUpgrade(SQLiteDatabase db, int oldVersion, int newVersion) {
        db.execSQL("DROP TABLE IF EXISTS " + TABLE_NAME);
        onCreate(db);
    }
}



21. For EditActivity.java, add this code:
	package edu.aamu.contacts;

import android.app.Activity;
import android.app.AlertDialog;
import android.content.ContentValues;
import android.content.DialogInterface;
import android.content.Intent;
import android.database.sqlite.SQLiteDatabase;
import android.os.Bundle;
import android.view.View;
import android.view.View.OnClickListener;
import android.widget.Button;
import android.widget.EditText;
import android.widget.Toast;

/**
 * Created by WChoosilp on 1/7/2016.
 */
public class EditActivity extends Activity implements OnClickListener {
    private Button btn_save;
    private Button btn_cancel;
    private EditText edit_first, edit_email, edit_phone, edit_officeN, edit_officeH;
    private DBHelper mHelper;
    private SQLiteDatabase dataBase;
    private String id, fname, eaddress, pnumber, onumber, ohours;
    private boolean isUpdate;

    @Override
    public void onCreate(Bundle savedInstanceState) {
        super.onCreate(savedInstanceState);
        setContentView(R.layout.layout_edit);

        btn_save = (Button) findViewById(R.id.save_btn);
        btn_cancel = (Button) findViewById(R.id.cancel_btn);
        edit_first = (EditText) findViewById(R.id.frst_editTxt);
        edit_email = (EditText) findViewById(R.id.email_editTxt);
        edit_phone = (EditText) findViewById(R.id.phone_editTxt);
        edit_officeN = (EditText) findViewById(R.id.officeN_editTxt);
        edit_officeH = (EditText) findViewById(R.id.officeH_editTxt);

        isUpdate = getIntent().getExtras().getBoolean("update");
        if (isUpdate) {
            id = getIntent().getExtras().getString("ID");
            fname = getIntent().getExtras().getString("Fname");
            eaddress = getIntent().getExtras().getString("Eaddress");
            pnumber = getIntent().getExtras().getString("Pnumber");
            onumber = getIntent().getExtras().getString("Onumber");
            ohours = getIntent().getExtras().getString("Ohours");
            edit_first.setText(fname);
            edit_email.setText(eaddress);
            edit_phone.setText(pnumber);
            edit_officeN.setText(onumber);
            edit_officeH.setText(ohours);
        }
        btn_save.setOnClickListener(this);
        mHelper = new DBHelper(this);

        cancelEvent();
    }

    private void cancelEvent() {
        btn_cancel = (Button) findViewById(R.id.cancel_btn);

        btn_cancel.setOnClickListener(new View.OnClickListener() {
            @Override
            public void onClick(View v) {
                Toast.makeText(EditActivity.this, "Back to the Main Page.", Toast.LENGTH_SHORT).show();
                startActivity(new Intent(EditActivity.this, MainActivity.class));
            }
        });
    }

    // saveButton click event
    public void onClick(View v) {
        fname = edit_first.getText().toString().trim();
        eaddress = edit_email.getText().toString().trim();
        pnumber = edit_phone.getText().toString().trim();
        onumber = edit_officeN.getText().toString().trim();
        ohours = edit_officeH.getText().toString().trim();
        if (fname.length() > 0 && eaddress.length() > 0 && pnumber.length() > 0 && onumber.length() > 0 && ohours.length() > 0) {
            saveData();
        } else {
            AlertDialog.Builder alertBuilder = new AlertDialog.Builder(EditActivity.this);
            alertBuilder.setTitle("Invalid Data");
            alertBuilder.setMessage("Please, Enter valid data");
            alertBuilder.setPositiveButton("Ok", new DialogInterface.OnClickListener() {

                public void onClick(DialogInterface dialog, int which) {
                    dialog.cancel();
                }
            });
            alertBuilder.create().show();
        }
    }

    /**
     * save data into SQLite
     */
    private void saveData() {
        dataBase = mHelper.getWritableDatabase();
        ContentValues values = new ContentValues();

        values.put(DBHelper.KEY_FNAME, fname);
        values.put(DBHelper.KEY_EADDRESS, eaddress);
        values.put(DBHelper.KEY_PNUMBER, pnumber);
        values.put(DBHelper.KEY_ONUMBER, onumber);
        values.put(DBHelper.KEY_OHOURS, ohours);

        System.out.println("");
        if (isUpdate) {
            //update database with new data
            dataBase.update(DBHelper.TABLE_NAME, values, DBHelper.KEY_ID + "=" + id, null);
        } else {
            //insert data into database
            dataBase.insert(DBHelper.TABLE_NAME, null, values);
        }
        //close database
        dataBase.close();
        finish();
    }
}



22. For LoginActivity.java, add this code:
	package edu.aamu.contacts;

import android.app.Activity;
import android.content.Intent;
import android.os.Bundle;
import android.view.View;
import android.view.View.OnClickListener;
import android.widget.Button;
import android.widget.EditText;
import android.widget.Toast;

/**
 * Created by WChoosilp on 1/7/2016.
 */
public class LoginActivity extends Activity {

    private EditText username = null;
    private EditText password = null;
    Button login;

    @Override
    protected void onCreate(Bundle savedInstanceState) {
        super.onCreate(savedInstanceState);
        setContentView(R.layout.layout_login);

        btnLogin();
    }

    private void btnLogin() {
        // TODO Auto-generated method stub
        login = (Button) findViewById(R.id.btnLogin);
        login.setOnClickListener(new OnClickListener() {
            @Override
            public void onClick(View arg0) {
                username = (EditText) findViewById(R.id.etUsername);
                password = (EditText) findViewById(R.id.etPassword);

                if (username.getText().toString().equals("admin")
                        && password.getText().toString().equals("admin")) {
                    startActivity(new Intent(LoginActivity.this, MainActivity.class));
                    LoginActivity.this.finish();
                } else {
                    Toast.makeText(getApplicationContext(),
                            "Incorrect Username/Password", Toast.LENGTH_SHORT).show();
                }
            }
        });
    }
}





23. For SplashActivity.java, add this code:
	package edu.aamu.contacts;

import android.app.Activity;
import android.content.Intent;
import android.os.Bundle;
import android.os.Handler;

/**
 * Created by WChoosilp on 1/7/2016.
 */
public class SplashActivity extends Activity {
    // Splash screen timer
    private static int SPLASH_TIME_OUT = 3000;

    @Override
    protected void onCreate(Bundle savedInstanceState) {
        super.onCreate(savedInstanceState);
        setContentView(R.layout.layout_splash);

        new Handler().postDelayed(new Runnable() {

            /*
             * Showing splash screen with a timer. This will be useful when you
             * want to show case your app logo / company
             */

            @Override
            public void run() {
                // This method will be executed once the timer is over
                // Start your app main activity
                Intent i = new Intent(SplashActivity.this, LoginActivity.class);
                startActivity(i);

                // close this activity
                finish();
            }
        }, SPLASH_TIME_OUT);
    }
}



24. Now, under the package directory, it should contain these classes:
[image: ]
25. We can run this application and test to see if it is working correctly.  To run this application, click Run 'app' (Shift + F10) on Android Studio.
26. If there is no error, the application should start with the Splash screen for 3 seconds and then it will go to the login screen.
[image: ]
27. Type admin/admin for User name and Password.  If you put anything else for the User name and Password, the application will show the warning message telling you "Incorrect Username/Password".
[image: ]








28. The main screen should look like this:
[image: ]
29. If you tab on Add New Contact button, it will open the new screen for adding contact's information.
[image: ]












30. Tab on Save, it will return to the main screen with the new contact that you just added.
[image: ]
31. If you tab on each contact, it will take you to the adding/editing screen, so you can make a change and update the contact.
32. If you tab and hold on each contact, you will have an option to delete that contact.
[image: ]











33. If you select Yes, the selected contact will be deleted from the record.
[image: ]




[bookmark: _Toc454951890]2.1.3 Android Robot Control System App
Lab Overview
This lab is intended to provide a comprehensive tutorial on interface designing in Android platform. A simple interface creation procedures of an Android based robot control application will be presented using different GUI components including textbox, buttons, label, seekBar etc. At the end of this lab the student will be able to design interfaces for different types of applications using both writing code and drag and drop feature of Android Studio. 
Lab Objectives
The main objectives include following four items: 
· To learn how to create AVD for Android application
· To learn how to create interface using XML 
· To be familiar with the several UI components and their uses
· To learn how to run Android application in physical device 
Lab Description 
Following lab description starts with configuration, followed project creation and stepwise layout and interface design instructions. 
1. 
2. 
2.1.2.1 Configuration
For the initial configuration, following steps need to be followed
i. To develop Android applications using Android Studio the JDK and JRE 1.7 must be installed in the computer.
ii. The API platform needs to be updated if it is not updated.
iii. API tools-- GPU debugging tools, Android support library, Intel X86 Emulator accelerator (HAXM installer) etc. are required to be installed if they are not previously installed. 
iv. The installation of API platform and API tools can be done from the SDK manager as shown in Fig. 1. To go to the SDK manager this icon needs to be selected from the tool bar at the top as shown below
Click here to navigate to the SDK Manager
Fig. 1: SDK Manager


  

v. After clicking on this icon the SDK Manager will appear as shown in Fig 2. From the SDK Manager check whether the listed tools are installed or not. If it is not installed, select the tool and click Apply from the SDK Manager.

Fig. 2 Updating SDK tools
Click apply after selecting the tool

2.1.2.2 Creating a New Project
i. Before start working, its needs to create a New Project. To create a New Project the following steps needs to be followed
ii. Go to File > New > New Project as shown in Fig. 3.
Fig. 3 Creating a New Project

iii. After that, a window will be popped up. Then put a project name in the Application Name and click Next as shown in Fig. 4.
Fig. 4 Creating a New Project
1.  Put your project name here
2. Click Next
Project location in the drive


iv. Next another window will be shown from where the SDK version can be customized as shown in Fig. 5. It is preferred to click Next without changing the SDK version because the Minimum SDK version is selected. If you want to change to upper SDK version it can be change from this window.Fig. 5: Configuring the target device


v. After that, the window for Activity will be appeared as shown in Fig. 6. For simple Android app it is recommended to select default Blank Activity. For other purpose, different Activity can be selected.
Fig. 6: Selecting Blank Activity

vi. After that, click Next and then Finish (as shown in Fig 8) to complete the project creation.
Fig. 7: Customizing the Activity
Click on Finish












After clicking on the Finish button, the project will be shown in the Left Bar of Android Studio as shown in Fig. 8.  The whole project name, including its current path can be made visible by navigating Android > Project shown in Fig 9. Fig. 9: Structure of a New Project
1
2
Fig. 8: Structure of a New Project
Project Structure


2.1.2.2 Creating Multiple Activities
For this application, we have multiple Activities. Except the MainActivity, we have to create some more Activities for other operations. So to create a New Activity, right click on app from the project structure and then go to   New Activity > Blank Activity. When there will be multiple Activities, we can set, which Activity will be started first while creating an Activity or later after Activity creation.

2.1.2.2 Designing the InterfaceFig. 10: Designing the interface
Layout
Layout for MainActivity

After creating a New Project, it needs to create an interface for the application. For this one, an interface for the Robot Control System will be designed. We have two activities for this application one is MainActivity and another one is CameraActivity .The interface will be designed by both XML and Drag and Drop option using the GUI component of Android Studio to have a comprehensive learning. For the designing, the following steps will be followed
i. From the project structure go to app > src > main > res > layout (shown in Fig.10) 

ii. Click on the activity_main.xml then a new window will be popped up at the central panel along with the XML resource shown in Fig 11.  It has two tabs at the bottom left corner—Design and Text.
Fig. 11: Desgining the interface

iii. To design the interface click on the Design tab which will let you design the interface using drag and drop feature using several GUI components as show in Fig. 12. In this window, you can change the attribute(s) of any specific components either changing XML code or by clicking on the Text tab or from the Properties tab from the right hand side.
GUI Compnents
Click on Design
Fig. 12: Desgining the interface
Text tab for changing the code for any specific component
Properties

iv. First, to change the background color of the application, click on the Text tab to open XML file and then copy and paste this line android:background="#277D9F"  at the first tag shown in Fig. 13. You can change to any other color using standard HexaDecimal color code.

		Fig. 13: Changing color
Add this line here

v. Now click on content_main.xml to customize the interface. All changes to the interface must be done from content_main.xml (Previously activity_main.xml in eclipse) and then select the Design tab. 

vi. Now select appTheme from the theme to have the complete layout of your project including you application name. This shown in Fig. 14.

	Fig. 14: Viewing the layout
AppTheme
App name

vii. To add button in the frame drag a button from Widgets and drop it on the frame. Reposition and resize it using mouse which is shown in Fig 15.  You can now add any GUI component to make an interface from this Palette. Drag a the button
After dropping the button
Fig. 15: Adding UI Component

viii. Next go to Text to change the attributes of the button. Now use add xml code for changing the color, margin and other properties as shown in Fig. 16. [n.b To change the attribute you can also use the Properties panel mentioned before].


Fig. 17: Layout of the application
SeekBar
Textbox
Fig. 16: Manipulating xml code
Add xml code here
Button after changing code

As you change the code, you can see the change simultaneously at the right hand side of the window as shown in Fig 16.
This is how the other GUI components including TextBox, Label, SeekBar etc. can be added in the interface. After the completion of designing, the interface for the MainActivity will look as shown in Fig 17
ix. Next, for the camera functionality, a new activity-- CameraActivity has to be created. For this right click on the app > New > Activity > Blank Activity. Name it as CameraActivity and then click Finish. You will see a new activity with new layout.
x. Design the activity as before. The interface of the Camera Activity should look like as follows.
                 		Fig. 16
Button for capturing picture
Button for recording video
Preview Window
Fig. 18: Layout of Camera Activity

2.1.2.2 Running the Application
After designing the interface, it needs to check on device. It can be done in two ways, either in Virtual device or in physical device.
2.1.2.2 Running the application in virtual device
For running the application in virtual device using Android Studio, the computer must support Virtualization Technology and the Hardware Acceleration tool must be installed properly and the installation procedure has been shown in Configuration earlier this lab. For running the application in virtual device an AVD must be configured as follows.Fig. 17: Creating AVD

i. [image: ]Go to AVD Manager by clicking on this icon from the top toolbar. After clicking this icon you will see a new window as show in in Fig. 17. From that window click on Create Virtual Device.

ii. From the next window select the specify the hardware which should resemble the physical device where the application is going to be launched and then click Next > Next > Finish.
Fig. 18: Creating AVD












[image: ]
iii. To run the application click on the run button and select the AVD you created as shown below.
2.1.2.2 Running the application in physical deviceList of AVD
Fig. 19: Running the app on AVD

To run the application in a physical device, the device must support Android and the USB debugging must be enabled. To enabled the USB debugging go to Settings > Developers options > USB debugging and then check mark the USB debugging.




[bookmark: _Toc454951891]Lab Unit 2.2 Use of database sqlite 
[bookmark: _Toc454951892]2.2.1. Lab Overview
Android provides database environment with SQLITE. This section is to explore the creation of database in Adrnoid platform. 
[bookmark: _Toc454951893]2.2.2. Lab Objectives
The main objectives include following items: 
· What are UI widgets that can be used for the interface design of Android apps
[bookmark: _Toc454951894]2.2.3. Lab Description 

In this lab, we are going to create an application that will allow user to create, retrieve, update, and delete data from the SQLite database. 
For the Table Structure, we will create a table called Student which will store student detail information such as name, phone number, and email.
	Student

	Primary Key
	id
	INTEGER

	
	name
email
age
	TEXT
TEXT
INTEGER



Steps:
1. Start Android Studio and create new project
· Application name: 	AAMU SQLite Example
· Company Domain:	aamu.edu
· Package name:		edu.aamu.sqlite.example
[image: ]
2. On Target Android Devices, select Phone and Tablet then set the Minimum SDK to API 15: Android 4.0.3 (IceCreamSandwich)
[image: ]
3. On Add and activity to Mobile, select Blank Activity
[image: ]
4. On Customize the Activity, leave everything as default.
[image: ]
5. First, let copy our aamu and bulldog logo into the drawable directory.
[image: ]        [image: C:\Users\WChoosilp\Downloads\AAMU Logo 3.jpg]
aamu.pgn                     bulldog.png

[image: ]
6. For the layout_content.xml file, replace with this code:
	<RelativeLayout xmlns:android="http://schemas.android.com/apk/res/android"
    xmlns:tools="http://schemas.android.com/tools"
    android:layout_width="match_parent"
    android:layout_height="match_parent"
    android:background="#8c0101"
    android:paddingBottom="@dimen/activity_vertical_margin"
    android:paddingLeft="@dimen/activity_horizontal_margin"
    android:paddingRight="@dimen/activity_horizontal_margin"
    android:paddingTop="@dimen/activity_vertical_margin">

    <Button
        android:id="@+id/btnAdd"
        android:layout_width="match_parent"
        android:layout_height="wrap_content"
        android:layout_alignParentBottom="true"
        android:text="Add" />

    <ListView
        android:id="@android:id/list"
        android:layout_width="match_parent"
        android:layout_height="wrap_content"
        android:layout_above="@+id/btnAdd"
        android:layout_below="@+id/imageView2"
        android:layout_centerHorizontal="true" />

    <ImageView
        android:id="@+id/imageView2"
        android:layout_width="120dp"
        android:layout_height="100dp"
        android:layout_alignParentTop="true"
        android:layout_centerHorizontal="true"
        android:background="@drawable/aamu" />

</RelativeLayout>



7. Create a new layout and name it as activity_student_detail.xml, then replace with this code:
	<RelativeLayout xmlns:android="http://schemas.android.com/apk/res/android"
    xmlns:tools="http://schemas.android.com/tools"
    android:layout_width="match_parent"
    android:layout_height="match_parent"
    android:background="#8c0101"
    android:paddingBottom="@dimen/activity_vertical_margin"
    android:paddingLeft="@dimen/activity_horizontal_margin"
    android:paddingRight="@dimen/activity_horizontal_margin"
    android:paddingTop="@dimen/activity_vertical_margin">

    <TextView
        android:id="@+id/textView"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:layout_alignParentLeft="true"
        android:layout_alignParentStart="true"
        android:layout_alignParentTop="true"
        android:layout_marginTop="30dp"
        android:text="Name"
        android:textAppearance="?android:attr/textAppearanceMedium" />

    <TextView
        android:id="@+id/textView2"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:layout_alignParentLeft="true"
        android:layout_alignParentStart="true"
        android:layout_below="@+id/textView"
        android:layout_marginTop="29dp"
        android:text="Email"
        android:textAppearance="?android:attr/textAppearanceMedium" />

    <TextView
        android:id="@+id/textView3"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:layout_alignParentLeft="true"
        android:layout_alignParentStart="true"
        android:layout_below="@+id/textView2"
        android:layout_marginTop="29dp"
        android:text="Age"
        android:textAppearance="?android:attr/textAppearanceMedium" />

    <EditText
        android:id="@+id/editTextName"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:layout_above="@+id/textView2"
        android:layout_alignParentEnd="true"
        android:layout_alignParentRight="true"
        android:layout_toRightOf="@+id/textView"
        android:ems="10"
        android:inputType="textPersonName" />

    <EditText
        android:id="@+id/editTextEmail"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:layout_above="@+id/textView3"
        android:layout_alignEnd="@+id/editTextName"
        android:layout_alignRight="@+id/editTextName"
        android:layout_toRightOf="@+id/textView"
        android:ems="10"
        android:inputType="textEmailAddress" />

    <EditText
        android:id="@+id/editTextAge"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:layout_alignBottom="@+id/textView3"
        android:layout_alignEnd="@+id/editTextEmail"
        android:layout_alignLeft="@+id/editTextEmail"
        android:layout_alignRight="@+id/editTextEmail"
        android:layout_alignStart="@+id/editTextEmail"
        android:autoText="false"
        android:inputType="number" />

    <Button
        android:id="@+id/btnSave"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:layout_alignParentBottom="true"
        android:layout_toLeftOf="@+id/btnClose"
        android:text="Save" />

    <Button
        android:id="@+id/btnClose"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:layout_alignParentBottom="true"
        android:layout_alignParentEnd="true"
        android:layout_alignParentRight="true"
        android:text="Close" />

    <Button
        android:id="@+id/btnDelete"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:layout_alignTop="@+id/btnSave"
        android:layout_toLeftOf="@+id/btnSave"
        android:text="Delete" />

</RelativeLayout>



8. Create another layout and name it as view_student_entry.xml and add this code:
	<?xml version="1.0" encoding="utf-8"?>

<RelativeLayout xmlns:android="http://schemas.android.com/apk/res/android"
    android:layout_width="match_parent"
    android:layout_height="match_parent"
    android:orientation="vertical"
    android:weightSum="1">

    <TextView
        android:id="@+id/student_Id"
        android:layout_width="fill_parent"
        android:layout_height="wrap_content"
        android:visibility="gone" />

    <TextView
        android:id="@+id/student_name"
        android:layout_width="289dp"
        android:layout_height="30dp"
        android:layout_alignBottom="@+id/imageView"
        android:layout_alignParentEnd="true"
        android:layout_alignParentRight="true"
        android:layout_below="@+id/student_Id"
        android:layout_toEndOf="@+id/imageView"
        android:layout_toRightOf="@+id/imageView"
        android:paddingLeft="6dip"
        android:paddingTop="6dip"
        android:textSize="22sp"
        android:textStyle="bold" />

    <ImageView
        android:id="@+id/imageView"
        android:layout_width="30dp"
        android:layout_height="30dp"
        android:background="@drawable/bulldog" />

</RelativeLayout>



9. For the activity_main.xml, you should not have to make any change and the code should look like this:
	<?xml version="1.0" encoding="utf-8"?>
<android.support.design.widget.CoordinatorLayout xmlns:android="http://schemas.android.com/apk/res/android"
    xmlns:app="http://schemas.android.com/apk/res-auto"
    xmlns:tools="http://schemas.android.com/tools"
    android:layout_width="match_parent"
    android:layout_height="match_parent"
    android:fitsSystemWindows="true"
    tools:context="edu.aamu.sqlite.example.MainActivity">

    <android.support.design.widget.AppBarLayout
        android:layout_width="match_parent"
        android:layout_height="wrap_content"
        android:theme="@style/AppTheme.AppBarOverlay">

    </android.support.design.widget.AppBarLayout>

    <include layout="@layout/content_main" />

    <android.support.design.widget.FloatingActionButton
        android:id="@+id/fab"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:layout_gravity="bottom|end"
        android:layout_margin="@dimen/fab_margin"
        android:src="@android:drawable/ic_dialog_email" />

</android.support.design.widget.CoordinatorLayout>



10. Now, let's implement the Java code in the edu.aamu.sqlite.example pacakge.
11. First, let's add this code for the MainActivity.java
	package edu.aamu.sqlite.example;

import android.app.ListActivity;
import android.content.Intent;
import android.support.v7.app.ActionBarActivity;
import android.support.v7.app.ActionBar;
import android.support.v4.app.Fragment;
import android.os.Bundle;
import android.view.LayoutInflater;
import android.view.Menu;
import android.view.MenuItem;
import android.view.View;
import android.view.ViewGroup;
import android.os.Build;
import android.widget.AdapterView;
import android.widget.Button;
import android.widget.ListAdapter;
import android.widget.ListView;
import android.widget.SimpleAdapter;
import android.widget.TextView;
import android.widget.Toast;

import java.util.ArrayList;
import java.util.HashMap;

public class MainActivity extends ListActivity implements android.view.View.OnClickListener {

    Button btnAdd;
    TextView student_Id;

    @Override
    public void onClick(View view) {
        if (view == findViewById(R.id.btnAdd)) {

            Intent intent = new Intent(this, StudentDetail.class);
            intent.putExtra("student_Id", 0);
            startActivity(intent);

        } else {

            StudentRepo repo = new StudentRepo(this);

            ArrayList<HashMap<String, String>> studentList = repo.getStudentList();
            if (studentList.size() != 0) {
                ListView lv = getListView();
                lv.setOnItemClickListener(new AdapterView.OnItemClickListener() {
                    @Override
                    public void onItemClick(AdapterView<?> parent, View view, int position, long id) {
                        student_Id = (TextView) view.findViewById(R.id.student_Id);
                        String studentId = student_Id.getText().toString();
                        Intent objIndent = new Intent(getApplicationContext(), StudentDetail.class);
                        objIndent.putExtra("student_Id", Integer.parseInt(studentId));
                        startActivity(objIndent);
                    }
                });
                ListAdapter adapter = new SimpleAdapter(MainActivity.this, studentList, R.layout.view_student_entry, new String[]{"id", "name"}, new int[]{R.id.student_Id, R.id.student_name});
                setListAdapter(adapter);
            } else {
                Toast.makeText(this, "No student!", Toast.LENGTH_SHORT).show();
            }

        }
    }

    @Override
    protected void onCreate(Bundle savedInstanceState) {
        super.onCreate(savedInstanceState);
        setContentView(R.layout.activity_main);

        btnAdd = (Button) findViewById(R.id.btnAdd);
        btnAdd.setOnClickListener(this);

        StudentRepo repo = new StudentRepo(this);

        ArrayList<HashMap<String, String>> studentList = repo.getStudentList();
        if (studentList.size() != 0) {
            ListView lv = getListView();
            lv.setOnItemClickListener(new AdapterView.OnItemClickListener() {
                @Override
                public void onItemClick(AdapterView<?> parent, View view, int position, long id) {
                    student_Id = (TextView) view.findViewById(R.id.student_Id);
                    String studentId = student_Id.getText().toString();
                    Intent objIndent = new Intent(getApplicationContext(), StudentDetail.class);
                    objIndent.putExtra("student_Id", Integer.parseInt(studentId));
                    startActivity(objIndent);
                }
            });
            ListAdapter adapter = new SimpleAdapter(MainActivity.this, studentList, R.layout.view_student_entry, new String[]{"id", "name"}, new int[]{R.id.student_Id, R.id.student_name});
            setListAdapter(adapter);
        } else {
            Toast.makeText(this, "No student!", Toast.LENGTH_SHORT).show();
        }
    }
}



12. Let's create a new class and name it as DBHelper.java and add this code:
	package edu.aamu.sqlite.example;

import android.content.Context;
import android.database.sqlite.SQLiteDatabase;
import android.database.sqlite.SQLiteOpenHelper;

/**
 * Created by WChoosilp on 1/9/2016.
 */
public class DBHelper extends SQLiteOpenHelper {
    //version number to upgrade database version
    //each time if you Add, Edit table, you need to change the
    //version number.
    private static final int DATABASE_VERSION = 5;

    // Database Name
    private static final String DATABASE_NAME = "crud.db";

    public DBHelper(Context context) {
        super(context, DATABASE_NAME, null, DATABASE_VERSION);
    }

    @Override
    public void onCreate(SQLiteDatabase db) {
        //All necessary tables you like to create will create here

        String CREATE_TABLE_STUDENT = "CREATE TABLE " + Student.TABLE + "("
                + Student.KEY_ID + " INTEGER PRIMARY KEY AUTOINCREMENT ,"
                + Student.KEY_name + " TEXT, "
                + Student.KEY_age + " INTEGER, "
                + Student.KEY_email + " TEXT )";

        db.execSQL(CREATE_TABLE_STUDENT);

    }

    @Override
    public void onUpgrade(SQLiteDatabase db, int oldVersion, int newVersion) {
        // Drop older table if existed, all data will be gone!!!
        db.execSQL("DROP TABLE IF EXISTS " + Student.TABLE);

        // Create tables again
        onCreate(db);

    }
}



13. Crate another class and name it as Student.java and add this code:
	package edu.aamu.sqlite.example;

/**
 * Created by WChoosilp on 1/9/2016.
 */
public class Student {
    // Labels table name
    public static final String TABLE = "Student";

    // Labels Table Columns names
    public static final String KEY_ID = "id";
    public static final String KEY_name = "name";
    public static final String KEY_email = "email";
    public static final String KEY_age = "age";

    // property help us to keep data
    public int student_ID;
    public String name;
    public String email;
    public int age;
}



14. Create another class and name it as StudentDetail.java and add this code:
	package edu.aamu.sqlite.example;

import android.content.Intent;
import android.support.v7.app.ActionBarActivity;
import android.os.Bundle;
import android.view.View;
import android.widget.Button;
import android.widget.EditText;
import android.widget.Toast;

/**
 * Created by WChoosilp on 1/9/2016.
 */
public class StudentDetail extends ActionBarActivity implements android.view.View.OnClickListener {

    Button btnSave, btnDelete;
    Button btnClose;
    EditText editTextName;
    EditText editTextEmail;
    EditText editTextAge;
    private int _Student_Id = 0;

    @Override
    protected void onCreate(Bundle savedInstanceState) {
        super.onCreate(savedInstanceState);
        setContentView(R.layout.activity_student_detail);

        btnSave = (Button) findViewById(R.id.btnSave);
        btnDelete = (Button) findViewById(R.id.btnDelete);
        btnClose = (Button) findViewById(R.id.btnClose);

        editTextName = (EditText) findViewById(R.id.editTextName);
        editTextEmail = (EditText) findViewById(R.id.editTextEmail);
        editTextAge = (EditText) findViewById(R.id.editTextAge);

        btnSave.setOnClickListener(this);
        btnDelete.setOnClickListener(this);
        btnClose.setOnClickListener(this);

        _Student_Id = 0;
        Intent intent = getIntent();
        _Student_Id = intent.getIntExtra("student_Id", 0);
        StudentRepo repo = new StudentRepo(this);
        Student student = new Student();
        student = repo.getStudentById(_Student_Id);

        editTextAge.setText(String.valueOf(student.age));
        editTextName.setText(student.name);
        editTextEmail.setText(student.email);
    }

    public void onClick(View view) {
        if ((view == findViewById(R.id.btnSave)) && (editTextName.getText().toString() == "")) {
            Toast.makeText(this, "Please enter the name.", Toast.LENGTH_SHORT).show();
        }
        if ((view == findViewById(R.id.btnSave)) && (editTextEmail.getText().toString() == "")) {
            Toast.makeText(this, "Please enter the email.", Toast.LENGTH_SHORT).show();
        }
        if (view == findViewById(R.id.btnSave)) {
            StudentRepo repo = new StudentRepo(this);
            Student student = new Student();
            student.age = Integer.parseInt(editTextAge.getText().toString());
            student.email = editTextEmail.getText().toString();
            student.name = editTextName.getText().toString();
            student.student_ID = _Student_Id;

            if (_Student_Id == 0) {
                _Student_Id = repo.insert(student);

                Toast.makeText(this, "New Student Insert", Toast.LENGTH_SHORT).show();
                startActivity(new Intent(StudentDetail.this, MainActivity.class));
                //dialog.dismiss();
            } else {

                repo.update(student);
                Toast.makeText(this, "Student Record updated", Toast.LENGTH_SHORT).show();
                startActivity(new Intent(StudentDetail.this, MainActivity.class));
            }
        } else if (view == findViewById(R.id.btnDelete)) {
            StudentRepo repo = new StudentRepo(this);
            repo.delete(_Student_Id);
            Toast.makeText(this, "Student Record Deleted", Toast.LENGTH_SHORT);
            finish();
            startActivity(new Intent(StudentDetail.this, MainActivity.class));
        } else if (view == findViewById(R.id.btnClose)) {
            finish();
        }
    }
}



15. Create one more class and name it as StudentRepo.java and add this code:
	package edu.aamu.sqlite.example;

import android.content.ContentValues;
import android.content.Context;
import android.database.Cursor;
import android.database.sqlite.SQLiteDatabase;

import java.util.ArrayList;
import java.util.HashMap;

/**
 * Created by WChoosilp on 1/9/2016.
 */
public class StudentRepo {
    private DBHelper dbHelper;

    public StudentRepo(Context context) {
        dbHelper = new DBHelper(context);
    }

    public int insert(Student student) {

        //Open connection to write data
        SQLiteDatabase db = dbHelper.getWritableDatabase();
        ContentValues values = new ContentValues();
        values.put(Student.KEY_age, student.age);
        values.put(Student.KEY_email, student.email);
        values.put(Student.KEY_name, student.name);

        // Inserting Row
        long student_Id = db.insert(Student.TABLE, null, values);
        db.close(); // Closing database connection
        return (int) student_Id;
    }

    public void delete(int student_Id) {

        SQLiteDatabase db = dbHelper.getWritableDatabase();
        // It's a good practice to use parameter ?, instead of concatenate string
        db.delete(Student.TABLE, Student.KEY_ID + "= ?", new String[]{String.valueOf(student_Id)});
        db.close(); // Closing database connection
    }

    public void update(Student student) {

        SQLiteDatabase db = dbHelper.getWritableDatabase();
        ContentValues values = new ContentValues();

        values.put(Student.KEY_age, student.age);
        values.put(Student.KEY_email, student.email);
        values.put(Student.KEY_name, student.name);

        // It's a good practice to use parameter ?, instead of concatenate string
        db.update(Student.TABLE, values, Student.KEY_ID + "= ?", new String[]{String.valueOf(student.student_ID)});
        db.close(); // Closing database connection
    }

    public ArrayList<HashMap<String, String>> getStudentList() {
        //Open connection to read only
        SQLiteDatabase db = dbHelper.getReadableDatabase();
        String selectQuery = "SELECT  " +
                Student.KEY_ID + "," +
                Student.KEY_name + "," +
                Student.KEY_email + "," +
                Student.KEY_age +
                " FROM " + Student.TABLE;

        //Student student = new Student();
        ArrayList<HashMap<String, String>> studentList = new ArrayList<HashMap<String, String>>();

        Cursor cursor = db.rawQuery(selectQuery, null);
        // looping through all rows and adding to list

        if (cursor.moveToFirst()) {
            do {
                HashMap<String, String> student = new HashMap<String, String>();
                student.put("id", cursor.getString(cursor.getColumnIndex(Student.KEY_ID)));
                student.put("name", cursor.getString(cursor.getColumnIndex(Student.KEY_name)));
                studentList.add(student);

            } while (cursor.moveToNext());
        }

        cursor.close();
        db.close();
        return studentList;
    }

    public Student getStudentById(int Id) {
        SQLiteDatabase db = dbHelper.getReadableDatabase();
        String selectQuery = "SELECT  " +
                Student.KEY_ID + "," +
                Student.KEY_name + "," +
                Student.KEY_email + "," +
                Student.KEY_age +
                " FROM " + Student.TABLE
                + " WHERE " +
                Student.KEY_ID + "=?";// It's a good practice to use parameter ?, instead of concatenate string

        int iCount = 0;
        Student student = new Student();

        Cursor cursor = db.rawQuery(selectQuery, new String[]{String.valueOf(Id)});

        if (cursor.moveToFirst()) {
            do {
                student.student_ID = cursor.getInt(cursor.getColumnIndex(Student.KEY_ID));
                student.name = cursor.getString(cursor.getColumnIndex(Student.KEY_name));
                student.email = cursor.getString(cursor.getColumnIndex(Student.KEY_email));
                student.age = cursor.getInt(cursor.getColumnIndex(Student.KEY_age));

            } while (cursor.moveToNext());
        }

        cursor.close();
        db.close();
        return student;
    }
}



16. Now, we can try to run this application and test it.  Click on 'Run app' or (Shift + F10).
17. If there is no error, you should see the application run as you see in the picture below.
[image: ]
18. Click on the Add button to add new contact.
19. Fill in the student's information and click Save button
[image: ]







20. The new contact will be saved in the database and display the name of the student in the main screen.
[image: ]
21. Click on the student name and the application will open the edit screen which will have the delete, save and close options to you to select.  Let's try to change the student name to Paul McCartney and click save.
[image: ]










22. The application should update the name and show it in the main screen.
[image: ]
23. Now, let's try to click on the student name again and this time we are going to click on delete button to see if we can remove this student information off the database.
24. The application should remove the contact and go back to the main screen.
[image: ]


[bookmark: _Toc454951895]Lab Unit III – System Analysis – Permission ID
First, we need to understand Android security in a system overview. Android applications runs on an open source operating system for mobile device, an application middleware, a Java software development kit, and a collection of system applications. Typically, Android applications consists of four components – Activity (defines an application’s user interface), Service (represents background processes), Content Provider (includes database, store, and shared resources), and Broadcast Receiver (receives from other applications). 
The android security mechanisms can be illustrated in three components: 
A. Each application is assigned a unique user ID, and installed as a separate user, to prevent applications from accessing information of another one.
B. Inter-process communication (IPC) provides a way for a process to obtain data from another one. It is a mechanism to provide difference processes/program to communicate within OS. 
C. Code signing. Each developer holds secrete key and public key to provide a certificate, which can be self-signed or third party signed. 
Item A and item B are complementary with each other in terms of process orientation. Next, we introduce Android permission system. 
Android permission system contains four types of permissions: 
	Types of Permissions
	Descriptions

	Normal 
	Applications get the permission automatically 

	Dangerous
	Requested by applications at installation time, granted by user. 

	Signature
	If requested permission with the same signature, it will be granted implicitly without ask user explicitly.  

	SignatureOrSystem
	A permission that the system grants only to applications that are in the Android system image or that are signed with the same certificate as the application that declared the permission.


<permission> is used for the permission is normally used. <uses-permission> is requested to run the application; if not grant this permission, the application cannot be run. 
[bookmark: _Toc454951896]Lab Unit 3.1. Interface of Permission in Android App
[bookmark: _Toc454951897]3.1.1. Lab Overview
This lab is to expose our students with permission system granted by user to understand security issues behind this grant. The fundamental knowledge here is the understand how to grant permission that an application requested. We split the lab into two pieces – user interface of Permission ID and display permissions. 
  
[bookmark: _Toc454951898]3.1.2. Lab Objectives
There are two main objectives regarding to the goal of understand permission based android security model: 
1. Understand the permissions types 
2. How to grant permissions based on user requested
3. What is the potential security issues for granting permissions to application

[bookmark: _Toc454951899]3.1.3. Lab Description 
1. First, start Android Studio and click on File -> New -> New Project...
2. Give the Application name as Permission ID, Company Domain as aamu.edu, Package name as edu.aamu.permission.id, then click Next
[image: ]
3. On Target Android Devices, check on Phone and Table and set the Minimum SDK to API 15: Android 4.0.3 (IceCreamSandwich), then click Next
[image: ]
4. On Add an activity to Mobile, select  Blank Activity.
[image: ]
5. On Customize the Activity, leave everything as default, then click Finish.
[image: ]
6. Wait until Android Studio finished creating our new project.
[image: ]
7. On Android Studio, it should look like this picture.
[image: ]
8. Double click on content_main.xml under the layout directory, then click on Design tab.
[image: ]
9. If you have an error message as shown in the picture, click on NoActionBar icon.
[image: ]
10. On the Select Theme window, change the Manifest Themes to AppCompat.Light.DarkActionBar, then click OK
[image: ]
11. Now the error message should disappear and Android Studio should look like this.
[image: ]
12. Go ahead and run the application by clicking on Run 'app' icon or hit (Shift + F10) keys
[image: ]
13. On Device Chooser, select Launch emulator and make sure that My Testing Device API 22 is selected an click OK.
[image: ]
14. After the My Testing Device API 22 emulator finished loading, you should see your application like this.
[image: ]
15. Now, leave the emulator running and let's go back to Android Studio and start developing our application.
16. Open the content_main.xml file and select the Design tab.
17. First select the Hello World! text and delete it.
[image: ]
18. Let's add the button onto our application.
19. Click on Small Button icon under Widgets and place it onto our application.
[image: ]
20. Double click on the button and named it "Show Permission ID" and give the button id as btnPermission.
[image: ]
21. Now let's add AAMU Logo into our application.
[image: C:\Users\WChoosilp\Downloads\aamu.png]
22. Before we can add the picture, we need to add that picture into our drawable source directory.  Right click on the picture and click Copy.
[image: ]
23. Go back to Android Studio and paste it into the drawable source directory.  The drawable source directory is located under res directory.
[image: ]
24. Click OK to copy the picture into drawable source directory.
[image: ]
25. Now that we have the picture, we need to display this picture into our application.
26. Click on Image View icon and place it into our application.
[image: ]
27. Go to the Properties and find background, click on the space on the right.
[image: ]
28. Then click on browse (...) button and the Resources window will show up. Click on Project tab and scroll down to drawable, you will see aamu picture listed. Select it and click OK.
[image: ]
29. The AAMU logo should show in our application like this.
[image: ]
30. Adjust the permission id button and the picture to make the application look good.
[image: ]
31. Click Run 'app' icon to test our application.
[image: ]

[bookmark: _Toc454951900]3.2. Display Permission of Android App
Lab Overview
This lab is to display permissions. 
  
Lab Objectives
There are two main objectives regarding to the goal of understand permission based android security model: 
1. Understand the permissions types 
2. Implements permissions based on user requested

Lab Description 
In this lab, we are going to create a simple Android app called Permission ID.  This lab is the follow up from the last lab (Interface Design of Permission ID).  If you have already done the last lab, you can skip session 1 and go to the session 2 and start.
Session 1: Design User Interface for Permission ID application
Steps:
32. First, start Android Studio and click on File -> New -> New Project...
33. Give the Application name as Permission ID, Company Domain as aamu.edu, Package name as edu.aamu.permission.id, then click Next

[image: ]
34. On Target Android Devices, check on Phone and Table and set the Minimum SDK to API 15: Android 4.0.3 (IceCreamSandwich), then click Next

[image: ]

35. On Add an activity to Mobile, select  Blank Activity.

[image: ]
36. On Customize the Activity, leave everything as default, then click Finish.

[image: ]

37. Wait until Android Studio finished creating our new project.

[image: ]





38. On Android Studio, it should look like this picture.

[image: ]

39. Double click on content_main.xml under the layout directory, then click on Design tab.

[image: ]




40. If you have an error message as shown in the picture, click on NoActionBar icon.

[image: ]

41. On the Select Theme window, change the Manifest Themes to AppCompat.Light.DarkActionBar, then click OK

[image: ]
42. Now the error message should disappear and Android Studio should look like this.

[image: ]

43. Go ahead and run the application by clicking on Run 'app' icon or hit (Shift + F10) keys

[image: ]



44. On Device Chooser, select Launch emulator and make sure that My Testing Device API 22 is selected an click OK.

[image: ]

45. After the My Testing Device API 22 emulator finished loading, you should see your application like this.

[image: ]
46. Now, leave the emulator running and let's go back to Android Studio. 
47. Open the content_main.xml file and select the Design tab and select the Hello World! text and delete it.

[image: ]

48. Let's add the button onto our application, clickinh on Small Button icon under Widgets and place it onto our application.
[image: ]

49. Double click on the button and named it "Show Permission ID" and give the button id as btnPermission.

[image: ]

50. Now let's add AAMU Logo into our application.

[image: C:\Users\WChoosilp\Downloads\aamu.png]

[image: C:\Users\WChoosilp\Downloads\aamu2.png]

51. Before we can add the picture, we need to add that picture into our drawable resource directory.  Right click on the picture and click Copy.

[image: ]

52. Go back to Android Studio and paste it into the drawable resource directory.  The drawable resource directory is located under res directory.

[image: ]



53. Click OK to copy the picture into drawable resource directory.

[image: ]

54. Do the same thing to add another picture (aamu2.png) to the drawable resource directory.
55. Now that we have the pictures, we need to display this picture into our application.
56. Click on Image View icon and place it into our application.

[image: ]










57. Go to the Properties and find background, click on the space on the right.

[image: ]

58. Then click on browse (...) button and the Resources window will show up. Click on Project tab and scroll down to drawable, you will see aamu picture listed. Select it and click OK.

[image: ]
59. The AAMU logo should show in our application like this.

[image: ]

60. Adjust the permission id button and the picture to make the application look good.

[image: ]




61. Click Run 'app' icon to test our application.

[image: ]



















Session 2: Implementation for Permission ID Application
Steps:
1. Create 3 new layouts for the activities needed in this application.
· permission_main.xml
· apk_package.xml
· apk_package_info.xml
2. Right click on layout resource directory and select New -> XML -> Layout XML File

[image: ]

3. On New Android Activity window, type permission_main for Layout File Name and click Finish.

[image: ]
4. Repeat step 2 to create apk_package.xml and apk_package_info.xml.  After finish creating these layout files, you should have 5 layout files in your layout resource directory as shown in the picture below.

[image: ]

5. For activity_main.xml, add this code
	<?xml version="1.0" encoding="utf-8"?>
<android.support.design.widget.CoordinatorLayout xmlns:android="http://schemas.android.com/apk/res/android"
    xmlns:app="http://schemas.android.com/apk/res-auto"
    xmlns:tools="http://schemas.android.com/tools"
    android:layout_width="match_parent"
    android:layout_height="match_parent"
    android:fitsSystemWindows="true"
    tools:context="edu.aamu.permission.id.MainActivity">

    <android.support.design.widget.AppBarLayout
        android:layout_width="match_parent"
        android:layout_height="wrap_content"
        android:theme="@style/AppTheme.AppBarOverlay">

        <android.support.v7.widget.Toolbar
            android:id="@+id/toolbar"
            android:layout_width="match_parent"
            android:layout_height="?attr/actionBarSize"
            android:background="?attr/colorPrimary"
            app:popupTheme="@style/AppTheme.PopupOverlay" />

    </android.support.design.widget.AppBarLayout>

    <include layout="@layout/content_main" />

    <android.support.design.widget.FloatingActionButton
        android:id="@+id/fab"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:layout_gravity="bottom|end"
        android:layout_margin="@dimen/fab_margin"
        android:src="@android:drawable/ic_dialog_email" />

</android.support.design.widget.CoordinatorLayout>



[image: ]

6. For content_main.xml, add this code
	<?xml version="1.0" encoding="utf-8"?>
<RelativeLayout xmlns:android="http://schemas.android.com/apk/res/android"
    xmlns:app="http://schemas.android.com/apk/res-auto"
    xmlns:tools="http://schemas.android.com/tools"
    android:layout_width="match_parent"
    android:layout_height="match_parent"
    android:paddingBottom="@dimen/activity_vertical_margin"
    android:paddingLeft="@dimen/activity_horizontal_margin"
    android:paddingRight="@dimen/activity_horizontal_margin"
    android:paddingTop="@dimen/activity_vertical_margin"
    app:layout_behavior="@string/appbar_scrolling_view_behavior"
    tools:context="edu.aamu.permission.id.MainActivity"
    tools:showIn="@layout/activity_main"
    android:background="#8c0101">

    <Button
        style="?android:attr/buttonStyleSmall"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:text="Show Permission ID"
        android:id="@+id/btnPermission"
        android:layout_alignParentTop="true"
        android:layout_alignParentRight="true"
        android:layout_alignParentEnd="true"
        android:layout_alignParentLeft="true"
        android:layout_alignParentStart="true" />

    <ImageView
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:id="@+id/imageView"
        android:background="@drawable/aamu"
        android:layout_alignParentBottom="true"
        android:layout_alignParentRight="true"
        android:layout_alignParentEnd="true"
        android:layout_marginBottom="44dp"
        android:layout_alignParentLeft="true"
        android:layout_alignParentStart="true"
        android:layout_below="@+id/btnPermission" />
</RelativeLayout>



[image: ]

7. For permission_main.xml, add this code
	<?xml version="1.0" encoding="utf-8"?>
<LinearLayout xmlns:android="http://schemas.android.com/apk/res/android"
    android:orientation="vertical"
    android:layout_width="fill_parent"
    android:layout_height="fill_parent"
    android:background="#8c0101">

    <Button
        style="?android:attr/buttonStyleSmall"
        android:layout_width="match_parent"
        android:layout_height="wrap_content"
        android:text="Back to Main Page"
        android:id="@+id/btnBack"
        android:layout_gravity="center_horizontal" />

    <EditText
        android:layout_width="match_parent"
        android:layout_height="wrap_content"
        android:id="@+id/editText"
        android:layout_gravity="center_horizontal"
        android:text="List of all installed applications in this device:" />

    <ListView
        android:id="@android:id/list"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content">
    </ListView>
</LinearLayout>



[image: ]

8. For apk_package.xml, add this code
	<?xml version="1.0" encoding="utf-8"?>

<RelativeLayout xmlns:android="http://schemas.android.com/apk/res/android"
    android:layout_width="wrap_content"
    android:layout_height="wrap_content"
    android:background="#8c0101">

    <Button
        style="?android:attr/buttonStyleSmall"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:text="Back to Previous Page"
        android:id="@+id/btnBack"
        android:layout_alignParentRight="true"
        android:layout_alignParentEnd="true"
        android:layout_alignParentLeft="true"
        android:layout_alignParentStart="true" />

    <LinearLayout android:id="@+id/fd"
        android:layout_width="fill_parent"
        android:layout_height="wrap_content"
        android:orientation="horizontal"
        android:layout_below="@+id/btnBack"
        android:layout_alignParentLeft="true"
        android:layout_alignParentStart="true">

        <ImageView
            android:id="@+id/appIcon"
            android:layout_width="64dp"
            android:layout_height="64dp"/>

        <LinearLayout android:layout_width="fill_parent"
            android:layout_height="wrap_content"
            android:orientation="vertical">

            <TextView
                android:id="@+id/appName"
                android:layout_height="wrap_content"
                android:layout_width="wrap_content"
                android:layout_gravity="center_vertical"/>

            <TextView
                android:id="@+id/appVersion"
                android:layout_height="wrap_content"
                android:layout_width="wrap_content"
                android:layout_gravity="center_vertical"/>
        </LinearLayout>

    </LinearLayout>

    <ListView
        android:id="@+id/permission_list"
        android:layout_width="fill_parent"
        android:layout_height="wrap_content"
        android:layout_below="@+id/fd"
        android:layout_above="@+id/imageView2">
    </ListView>

    <ImageView
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:id="@+id/imageView2"
        android:background="@drawable/aamu2"
        android:layout_alignParentBottom="true" />

</RelativeLayout>



[image: ]

9. For apk_package_info.xml, add this code
	<?xml version="1.0" encoding="utf-8"?>
<LinearLayout xmlns:android="http://schemas.android.com/apk/res/android"
    android:layout_width="match_parent"
    android:layout_height="match_parent">

    <ImageView
        android:id="@+id/imageView1"
        android:adjustViewBounds="true"
        android:maxWidth="32dp"
        android:maxHeight="32dp"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content" />

    <TextView
        android:id="@+id/name"
        android:layout_height="wrap_content"
        android:layout_width="wrap_content"
        android:layout_gravity="center_vertical"
        />

</LinearLayout>



[image: ]

10. Create new classes under edu.aamu.permission.id package.

[image: ]






11. On Create New Class window, type PermissionActivity as the Name, then click OK

[image: ]

Then add this code.
	package edu.aamu.permission.id;

import android.app.ListActivity;
import android.content.Intent;
import android.content.pm.PackageInfo;
import android.content.pm.PackageManager;
import android.os.Bundle;
import android.view.*;
import android.widget.Button;
import android.widget.ListView;
import android.widget.SearchView;
import android.widget.Toast;

import java.util.List;

/**
 * Created by WChoosilp on 1/5/2016.
 */
public class PermissionActivity extends ListActivity {
    Button back;

    @Override
    public void onCreate(Bundle savedInstanceState)
    {
        super.onCreate(savedInstanceState);
        setContentView(R.layout.permission_main);

        PackageManager p = getPackageManager();
        List<PackageInfo> appInstall = p.getInstalledPackages(PackageManager.GET_PERMISSIONS | PackageManager.GET_PROVIDERS);

        PackageInfoAdapter adapter = new PackageInfoAdapter(this, appInstall);
        setListAdapter(adapter);

        backToMain();
    }

    private void backToMain() {
        back = (Button) findViewById(R.id.btnBack);

        // set the click listener to run the code
        back.setOnClickListener(new View.OnClickListener() {

            @Override
            public void onClick(View v) {
                Toast.makeText(PermissionActivity.this, "Back to the Main Page.", Toast.LENGTH_SHORT).show();
                startActivity(new Intent(PermissionActivity.this, MainActivity.class));
            }
        });
    }

    @Override
    protected void onListItemClick(ListView l, View v, int position, long id)
    {
        PackageInfo packageInfo = (PackageInfo)l.getAdapter().getItem(position);

        Intent intent = new Intent(this, PackageInfoActivity.class);
        intent.putExtra("packageInfo", packageInfo);

        this.startActivity(intent);
    }
}



12. Create another class and name it as PermissionAdapter, then click OK

[image: ]

Then add this code.
	package edu.aamu.permission.id;

import android.content.Context;
import android.view.View;
import android.view.ViewGroup;
import android.widget.ArrayAdapter;
import android.widget.TextView;

import java.util.List;

/**
 * Created by WChoosilp on 1/5/2016.
 */
public class PermissionAdapter extends ArrayAdapter<Permission>
{
    private final Context context;
    private final List<Permission> values;

    public PermissionAdapter(Context context, List<Permission> values)
    {
        super(context, R.layout.apk_package_info, values);
        this.context = context;
        this.values = values;
    }

    @Override
    public View getView(int position, View convertView, ViewGroup parent)
    {
        Permission permission = values.get(position);

        TextView textView = new TextView(context);
        textView.setText(permission.printName());

        return textView;
    }
}



13. Create another class and name it as Permission, then click OK

[image: ]

Then add this code.
	package edu.aamu.permission.id;

/**
 * Created by WChoosilp on 1/5/2016.
 */
public class Permission
{
    private String m_name;

    public Permission(String name)
    {
        m_name = name;
    }

    public String printName()
    {
        String formattedPermission = "";

        String[] split = getName().split("\\.");
        if(split.length >= 1)
        {
            formattedPermission = split[split.length - 1];

        }
        return formattedPermission;
    }

    public String getName()
    {
        return m_name;
    }
}



14. Create another class and name it as PackageInfoAdapter, then click OK

[image: ]

Then add this code.
	package edu.aamu.permission.id;

import android.content.Context;
import android.content.pm.ApplicationInfo;
import android.content.pm.PackageInfo;
import android.graphics.drawable.Drawable;
import android.view.LayoutInflater;
import android.view.View;
import android.view.ViewGroup;
import android.widget.ArrayAdapter;
import android.widget.Filter;
import android.widget.ImageView;
import android.widget.TextView;
import java.util.ArrayList;
import java.util.Iterator;
import java.util.List;

/**
 * Created by WChoosilp on 1/5/2016.
 */

public class PackageInfoAdapter extends ArrayAdapter<PackageInfo>
{
    static class ViewHolder
    {
        public TextView textView;
        public ImageView imageView;
    }

    private final Context context;
    private final List<PackageInfo> packageInfoList;

    public PackageInfoAdapter(Context context, List<PackageInfo> values)
    {
        super(context, R.layout.apk_package_info, values);
        this.context = context;

        packageInfoList = new ArrayList<PackageInfo>(values);
    }

    @Override
    public View getView(int position, View convertView, ViewGroup parent)
    {
        View rowView = convertView;
        if (rowView == null)
        {
            LayoutInflater layoutInflater = (LayoutInflater) context.getSystemService(Context.LAYOUT_INFLATER_SERVICE);
            rowView = layoutInflater.inflate(R.layout.apk_package_info, parent, false);

            ViewHolder viewHolder = new ViewHolder();
            viewHolder.textView = (TextView) rowView.findViewById(R.id.name);
            viewHolder.imageView = (ImageView) rowView.findViewById(R.id.imageView1);

            rowView.setTag(viewHolder);
        }

        ViewHolder holder = (ViewHolder) rowView.getTag();

        String appName = getItem(position).applicationInfo.loadLabel(getContext().getPackageManager()).toString();
        Drawable appIcon =  getItem(position).applicationInfo.loadIcon(getContext().getPackageManager());
        holder.textView.setText(appName);
        holder.imageView.setImageDrawable(appIcon);

        return rowView;
    }

    public void showSystemApplications(boolean value)
    {
        List<PackageInfo> newValues = null;

        if(value == true)
        {
            newValues = new ArrayList<PackageInfo>(packageInfoList);
        }
        else
        {
            newValues = filterOutSystemApplications(packageInfoList);
        }

        clear();
        addAll(newValues);

        notifyDataSetChanged();
    }

    private List<PackageInfo> filterOutSystemApplications(List<PackageInfo> values)
    {
        List<PackageInfo> newValues = new ArrayList<PackageInfo>();

        for(PackageInfo packageInfo: values)
        {
            int isSystemApp =  packageInfo.applicationInfo.flags & ApplicationInfo.FLAG_SYSTEM;
            if(isSystemApp == 0)
            {
                newValues.add(packageInfo);
            }
        }

        return newValues;
    }

    @Override
    public Filter getFilter()
    {
        return new Filter()
        {
            @Override
            protected Filter.FilterResults performFiltering(CharSequence charSequence)
            {
                String lowerCaseSearchTerm = charSequence.toString().toLowerCase();

                FilterResults results = new FilterResults();
                List<PackageInfo> filteredResults = new ArrayList<PackageInfo>();
                for(PackageInfo packageInfo: packageInfoList)
                {
                    String appName = packageInfo.applicationInfo.loadLabel(getContext().getPackageManager()).toString();
                    if(appName.toLowerCase().contains(lowerCaseSearchTerm))
                    {
                        filteredResults.add(packageInfo);
                    }
                }

                results.values =  filteredResults;
                return results;
            }

            @Override
            protected void publishResults(CharSequence charSequence, FilterResults filterResults)
            {
                final ArrayList<PackageInfo> localItems = (ArrayList<PackageInfo>) filterResults.values;
                notifyDataSetChanged();
                clear();

                for (Iterator iterator = localItems.iterator(); iterator.hasNext();)
                {
                    PackageInfo gi = (PackageInfo) iterator.next();
                    add(gi);
                }
            }
        };
    }
}
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